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Section 1 - Introduction to the TruCAM

Congratulations on the purchase of your Laser Technology Inc; (LTI) TruCAM from Tele Traffic UK Ltd.
The TruCAM is an all-in-one digital video cameral/laser speed and ranging device. The TruCAM not
only measures speed, it can calculate the travelling time and distance between two following

vehicles and produces full action video and still image evidence, for both speeding and tailgating
Road Traffic Offence’s.

« Standard Capture Modes: Speed Mode.

» Rear Plate Mode and Video Only Mode.

* Motion clip and still image capture.

* Linux operating system with custom device drivers.

» High-Speed USB 2.0 connection.

* Built-in 20 channel Global Positioning System (GPS) receiver for Automatic Time correction.
Long battery life.

Unpacking Your TruCAM

When you receive your TruCAM, check to make sure that you received everything that you ordered,
and that it all arrived undamaged.

TruCAM Basic Package Optional Features

[J TruCAM Instrument [J] Distance between Cars (DBC)
(] SD Memory Card

[] SD Card to USB Reader Available Accessories

[] Battery Pack

[ Battery Charger, 110/200 v ac [J 3.5 X Scope Magnifier

[] Sun Shade [ Serial Cable (6-pin to DB9)
[] Stylus (3) [J Monopod

[[] Shoulder Rest [] Tripod

[J TruCAM Image Viewer Software [ 12V Automobile Charger
[] Carrying Case [] 2 x Camera Extender

[J UK User’s Manual [ ] Automobile charging cable
[J TruCAM Tripod Yoke

Important Safety Information

Misusing the battery may cause the battery to get hot, rupture or ignite and cause serious injury.
Be sure to follow the safety rules listed below:

» Do not place the battery in fire or heat the battery.

* Do not install the battery backwards so the polarity is reversed.

* Do not connect the positive terminal and the negative terminal of the battery to each other with any
metal object (such as wire).

* Do not carry or store the battery with hairpins, necklaces or other metal objects.

* Do not pierce the battery with nails, strike the battery with a hammer, step on the battery or otherwise
subject it to strong impacts or shocks.

* Do not solder directly onto the battery.

* Do not expose the battery to water, salt water or allow the battery to get wet.
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Do not disassemble or modify the battery.
The battery contains safety and protection devices, which, if damaged, may cause the battery to
generate heat, rupture or ignite.

Do not place the battery or near fires, stoves or other high-temperature locations.

Do not set or store TruCAM lithium ion batteries in direct sunshine. When storing batteries inside cars in
hot weather be sure to keep them shaded and out of direct sun. Direct sun or extreme hot temperatures
may cause the battery to heat up, rupture or ignite. Using the battery in this manner may also result in a
loss of performance and a shortened life expectancy.

Do not discharge the battery using any device except the TruCAM.

Using the battery in a device other than the TruCAM may damage the performance of the battery or
reduce its life expectancy, and if the device causes abnormal current flow, it may cause the battery to
become hot, rupture or ignite and cause serious injury.

Li-ion battery cells can become unstable (potentially dangerous) at low and high temperatures.

* Charging Temperature Range: 0°C to +45°C (+32°F to +113°F).
» Storage Temperature Range: -20°C to +60°C (-4°F to +140°F).

Contact Tele Traffic UK Ltd if any of these problems are observed:

Immediately discontinue use of the battery if, while using, charging or storing the battery,
the battery unit emits an unusual smell, feels hot, changes colour, changes shape or appears
abnormal in any other way.

Never attempt to view the sun through the scope.
Looking at sun through the scope may permanently damage your eyes.

Avoid staring directly at the laser beam for prolonged periods.

The TruCAM is designed to meet strict eye safety requirements and is classified as eye-safe to Class
1 limits, which means that virtually no hazard is associated with directly viewing the laser output under
normal conditions. As with any laser device, reasonable precautions should be taken in its operation.
It is recommended that you avoid staring into the transmit lens while firing the laser. The use of optical
instruments with this product may increase eye hazard.

Never point the instrument directly at the sun.
Exposing the lens system to direct sunlight, even for a brief period, may permanently damage the laser
transmitter.

Never point the device at civil or military aircraft, vessel or armoured vehicles (they may initiate
counter measures)

Do not operate the instrument in extreme temperatures.
» TruCAM components are rated for a temperature range of -10°C to +60°C (14°F to 140°F).
* Do not operate the instrument in temperatures outside that range.
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Views of the TruCAM

Front/Left Side Front/Right Side Rear/Right Side

Sighting Scope
Transmit Lens
Camera Lens
Receive Lens
Handle/ Battery Compartment
Battery Pack
LED Charge Indicator
Battery Release
Shoulder Stock Release
10. Stylus and Holder
11. SD Card Slot/ USB Port Cover
12. Camera Cover
13. Focus Adjustment Ring
14. Iris Adjustment Ring
15. Trigger
16. Shoulder Stock A.P.
17. Rear Panel
18. LCD Touch Screen
19. Function Buttons
(Red, Green, Blue & Yellow).
20. Power Button
21. Speaker
22. Serial Port

COoNO>GORWN =
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Quick Start

This section demonstrates the basic speed measurement and still image, motion clip capture and the
playback process.

Preparation:

1. If necessary, charge the Battery Pack (page 6).
2. If necessary, insert the Battery Pack into the Handle (page 8).
3. Insert the SD Card into the SD Card Slot (page 12).

Speed Measurement, Still Image and Motion Clip Capture:

Selecting a Target Step 1:Press and release the Power button. Initially, the TruCAM Splash screen will
be displayed on the LCD Touch Screen. Then the Self Test Results Screen will be displayed briefly
before the System Setup Screen is displayed. Locate a target with defined edges that are approximately
70 metres away.

A street sign is ideal. The specific distance is not critical, but the camera’s optimum targeting
distance is 70 metres.
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Focusing the Camera:

1

. Pull and release the TRIGGER to start the live video function. Briefly

. Open the camera cover to allow access to the Focus Adjustment Ring
. Aim the TruCAM at a target as described in step 1 above and adjust
. Tap @ or press the D soft key to display the other options on the

. Tap or press the - soft key to increase the screen

the screen should look similar to Figure 2. Then the live video will
appear in the upper half of the screen.

and the Iris Adjustment Ring.

the iris to allow for a bright detailed picture of the screen.

Caption Session Toolbar.

magnification. This will make it easier to set the correct focus.

By continuing to tap or by pressing the . soft key will to return the screen image to the
normal magnification display before taking a speed measurement.

. If necessary, tap or press the - soft key to adjust the shutter speed.

Taking a Sample Speed Measurement:

1.

2.

If Speed Mode is not active, tap = or press the - soft key.

Use the sighting scope and aiming reticule to aim the TruCAM to the selected target.

. To fire the laser, pull and hold the TRIGGER. The laser will fire after a short delay.

. Continue to press the TRIGGER and keep the instrument sighted on the target:

A low-pitched growl means that the instrument is attempting to lock onto the target.

One Low-Pitched and two High-Pitched Beeps mean that a measurement error occurred.

An error message will be displayed.

A high-pitched single beep means that a speed was captured. The measured speed will be displayed
on the LCD screen and will be projected in the scope, just below the aiming reticule.

. Release the TRIGGER. The vehicle image, measured speed and distance will be displayed. If you

did not capture a speed, an error message will be displayed. Repeat all the above steps.
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Motion Clip Playback:

1. Tap or press the - soft key. A preview of the still image is displayed.
It should look similar to Figure 3.

2. Tap or press the D soft key to load the motion clip/still image file.

Toolbar Alternative Yoty A—- 2l fm

Function

Button Soft Key

Tap to load the motion clip/still image.

Tap to advance one frame.

IS1Z272818 11:38:49 . 344

Tap to play the motion clip. As the motion clip is
being played, the frame number will be updated.

26 v

9.6 m

This button is displayed while the motion clip is

being played back. Tap to stop the playback. . :

Tap to reload the motion clip.

Tap to change the brightness of the LCD
Backlight.

Tap to load the still image.

Tap to enlarge detail of the
displayed image.

EecoeoopoecE

Tap to restore normal display.

08808080080

®

Tap to return to Playback Mode.

Exiting Playback Mode:
When you are ready to exit Playback Mode:

» To power OFF the TruCAM, press and hold the Power button.
« To display the System Setup Screen, press and release the Power button.
* To return to Capture Mode, pull the TRIGGER.
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Section 2 - TruCAM Components

Power Supply

A Lithium-ion Polymer rechargeable Battery Pack powers the TruCAM. The Battery Pack is located in
the TruCAM’s handle. It is protected from short circuit and overcharge, and will provide 9 to 15 hours of
cordless operation.

Charging the Battery Pack

WARNING

Be sure to follow the instructions below while charging the battery.
Failure to do so may cause the battery to become hot, rupture or ignite and cause serious injury.

» When charging the battery, use the charging cable that shipped with your TruCAM.

* Do not attach the battery to a power supply plug or directly to a car’s cigarette lighter.

» Do not place the battery in or near fire, or into direct sunlight. When the battery becomes hot, the
built-in safety equipment is activated, preventing the battery from charging further. Heating the battery
can destroy the safety equipment and cause additional heating, breaking or ignition of the battery.

Do not continue charging the battery if it does not recharge within the specified charging time. Doing so
may cause the battery to become hot, rupture or ignite.

CAUTION

Li-ion battery cells can become unstable (potentially dangerous) at low and high temperatures.
Charging Temperature Range: 0°C to 45°C (32° F to 113°F). Charging the battery outside of this range
may cause the battery to become hot or to break. Charging the battery outside of this temperature
range may also harm the performance of the battery or reduce the battery’s life expectancy.

Do not leave the battery unattended while charging.

Immediately unplug the charging cable if during the charging process, the battery emits an unusual
smell, feels hot, changes colour, changes shape or appears abnormal in any other way. Contact Tele
Traffic UK Ltd if any of these problems are observed.

To avoid damaging your TruCAM or the Charging Cable, check to be sure all connectors are properly
aligned before connecting them.

If battery voltage is below normal operation level (page 9), please
power OFF the TruCAM and recharge the Battery Pack as soon as
possible. The Charging Cable works in a standard electrical outlet.
You can also charge your TruCAM in your automobile with an optional
Automobile Charger that works in your vehicle’s electrical cigarette
lighter or a 12-volt power outlet.

1. Plug the appropriate end of the Charging Cable into the bottom of
the battery pack as shown in Figure 4. Before applying any force,
ensure that the pins in the bottom of the handle are aligned with the
Charging Cable.

2. Plug the other end of the Charging Cable into a power outlet.
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The colour of the LED charge indicator (see Figure 5) on the handle indicates battery charge status:

. = charging. Charging time is about 4.5 hours or less.
If the LED is not illuminated, refer to the Pre-Charging Routine (see next page).
Green = fully charged.
. blinking = malfunction. Contact Tele Traffic UK Ltd for repair.
See inside front cover for Tele Traffic contact information.

3. When finished charging, disconnect the Charging Cable from the power outlet, and then disconnect
from the TruCAM by gripping and pulling the green connector plug.

Note:

If the battery charge is very low, the LED Charge Indicator may not illuminate when you plug in the
Charging Cabile. Li-ion battery cells must have a nominal voltage of approximately 2 volts within them
before a large amount of current can be applied. If the cells are below 2 volts, applying a high current
could be dangerous. Therefore, if the cell voltage is less than the nominal 2 volts, the internal charging
circuit supplies a very small amount of current to slowly bring the battery charge up to a nominal voltage.

Pre-charging Routine
If the LED Charge Indicator does not illuminate when the Charging Cable is plugged in:
1. Leave it plugged in for at least one hour to trickle charge the Battery Pack.
If after one hour there is a good level of voltage, charging can occur.
2. Disconnect both ends of the Charging Cable.

3. Reconnect both ends of the Charging Cable.

- If enough voltage is present, charging will start and the LED will be orange.
- If the LED Charge indicator still does not illuminate, contact Tele Traffic UK Ltd
for assistance. See the inside front cover for LTI contact information.

Refer to the Charging the Battery Pack Instructions (previous page).
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Inserting the Battery Pack into the Handle.

The Battery Compartment is designed so the Battery Pack only fits if inserted correctly.
1. Align the notched edges of the Battery Pack with those of the Battery Compartment.
2. Slide the pack halfway into the compartment.

3. Using the palm of your hand and smooth, firm motion slide the Battery Pack up until it locks into
place. The required force is similar to the force required to insert a magazine into a firearm.

Removing the Battery Pack from the Handle
1. Hold the TruCAM with one hand and hold the bottom of the Handle with your other hand.

2. Press the Battery Release: simultaneously press the black buttons on both sides of the TruCAM,
just behind the TRIGGER.

3. Slide the Battery Pack out of the Battery Compartment.
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Understanding the Battery Voltage Icon

The TruCAM continuously monitors its power source. LTIl has defined an acceptable battery voltage
range to ensure that the instrument has sufficient battery voltage to guarantee correct operation. The
battery icon is located in the upper right corner of the LCD Touch Screen.

Appearance Explanation

of the Battery Icon

4 segments lit = 75% - 100% estimated battery life.

3 segments lit = 50% - 75% estimated battery life.

2 segments lit = 25% - 50% estimated battery life.

1 segment lit = 5% - 25% estimated battery life.

0 segments lit and red X’ = 5% or less estimated battery life. You need to
replace or recharge the battery pack as soon as possible.

=
:

Laser Sensors

The TruCAM has three lenses on the front panel. The smaller lens is the Camera Lens. The top lens
transmits the infrared laser signals. The bottom lens receives the signals back from the target and feeds
signal information to the internal circuitry.

The internal circuitry consists of a laser range sensor, timing, analysis, computation, and display
circuits. The TruCAM determines distance through its laser range sensor, by measuring the time of
flight of short pulses of infrared light. The TruCAM has a broad spectrum of sensitivity and can work
with both reflective and non-reflective targets. The maximum measurement distance varies with target
and environmental conditions. The United Kingdom version has a maximum range of 750 metres.

The laser diode emits light in the infrared portion of the electromagnetic spectrum. Infrared light is
invisible to the human eye and cannot be a distraction to drivers or operators.

Camera

The camera captures single frames as well as continuous motion clips. Specifications include CMOS
imaging technology, 3-megapixel resolution, and 12.7 mm (1/2-inch) optical format.

Adjustable Settings:

» Automatic Gain Control (page 33)
» Camera Lens Focus Distance
(page 34)

Iris (page 33)

Shutter Speed (page 34)

Camera Cover

Tab

To open the Camera Cover: Hinge

1. Press the tab on the underside of | Focus Adjustment Ring
the camera. There is a hinge that Iris Adjustment
secures the cover to the TruCAM. Slot

To close the Lens Cover:

1. Push the cover down to close it.
2. Secure the tab on the underside of _
the cover in the slot. Figure 8
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Sighting Scope

A single-power sighting scope is mounted on top of the TruCAM as Standard, however there is an
option to attach a 3.5 power magnifier if required.

The polarizing light filter is adjustable to optimise viewing contrast.

Figure 9 shows the polarizing light filter’s adjustment ring. The in-scope aiming reticule helps
you aim accurately to the target.

Figure 10 shows the reticule. This reticule represents the approximate size of the laser beam
on the target.

In-scope speed measurement display.

Filter Adjustment

Ring
.¢,.
br06

Adjusting the Aiming Reticule’s Intensity.

You can vary the intensity of the aiming reticule to account for different lighting conditions. The in-scope
aiming reticule has eight intensity settings from DIM (01) to BRIGHT (08).

1.

Tap or press the - soft key. The display should look similar to Figure 11. The factory default
setting is “br06”

. Repeat tapping or pressing the - soft key until the desired setting is achieved. It's easy to

get the desired setting if you look through the scope while making the adjustment.

Each time you press the button, the “brxx” value increases by 1.
If you press the button while “br08” is displayed, you will see “br01” next.

. Pull the TRIGGER to accept the current setting.

Powering OFF the instrument does not change this setting. The next time the instrument
is powered ON, the setting will be the same.

Restoring the Factory Default Settings (page 52) resets this value to br06.
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Secure Digital (SD) Card.

Caution

* Do not remove the SD Card when the TruCAM is powered ON. To do so could damage the SD Card.
* If necessary, the TruCAM will attempt to recover (repair) damaged file system on the SD Card (page 19).

SD Card
(enlarged to
show detail)

Figure 12

All data is stored on the removable SD card.

Each file contains the motion clip, still image, and all associated data.

Each file is encrypted using the AES-128* data encryption standard.

The number of files that can be saved on each SD card depends upon the SD card size, the image
size selected and the length of video captured for each file. For a 4 GB SD card, the average is

approximately 2,000 files stored.

The SD Card Slot is located under the cover that is part of the rear rubber bumper and is on the same
side as the Camera.

The Cover opens from the top down. The SD Card must be installed before power ON. Refer to Figure
12 when inserting the SD Card.

Do not insert the card upside down; make sure that the label is up. The SD card is asymmetrically
shaped in order not to be inserted upside down.

For information about SD Card format requirements see page 71.

The SD Card includes the TruCAM folder and two subfolders:

1.film Motion clips Contains many folders. Folder names are 5 characters (MM_DD).

Where MM is the month and DD is the date. Example:
Still images 05_04 = May 4th. Example motion clip/still image file name:
228306087_D1000_1203_120807.jmf

System configuration data: operator name, operator ID, and

2.config Daily data non-critical data like LCD backlight level, HUD brightness, etc.

1 © Tele-Traffic UK Ltd 2011



USB Port

The TruCAM’s High-Speed USB 2.0 connection is located under
the cover that is part of the rear rubber bumper and is on the
same side as the Camera. See Figure 13.

The Cover opens from the top down. The USB connection allows
you to copy files from the TruCAM/SD Card to the Office PC. The
TruCAM is not supplied as standard with a USB cable. Please
see accessorise.

USB Cable requirements:

High-Speed USB 2.0

Length: 1-2 metres (3 - 6 feet)

Ferrite core (see Figure 14)

A High-Speed USB 2.0 cable used to transfer data from a digital
camera or scanner to a PC should be compatible with the TruCAM

Copying Files from the TruCAM SD Card to the Office PC
1. Power ON the TruCAM.

2. Connect the appropriate end of the USB Cable to the TruCAM.

3. Connect the other end of the cable to the PC. The TruCAM will
detect the USB connection. Figure 15 shows the screen that will
be displayed.

4. On the Office PC, use My Computer or Microsoft Windows Explorer
to navigate to the SD Card. The SD Card will appear as Drive
Letter: Removable Disk. The drive letter varies and depends upon
how your computer is setup.

* The files in the directory displayed on the PC are Read Only.

* You can copy the files from the SD card onto your PC.

* You cannot delete files or write files to the TruCAM SD Card.

« Since you cannot change the contents of the SD card, the USB
cable can be removed at any time without concern of lost files or
corrupting the file structure on the SD card.

The TruCAM will automatically power OFF 60 seconds after the
USB cable is unplugged. In Figure 16 the TruCAM will power OFF
in 50 seconds. The TruCAM will countdown the seconds until the
unit powers OFF. The cable can be reconnected anytime during the
countdown process.

Ferrite Core

Figure 14

Figure 16

12
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Real Time Clock

The TruCAM’s internal system clock is a Real Time Clock (RTC), and its accuracy is 20 parts per million
(ppm) over the full operating temperature of -30°C to +60°C (-22°F to +140°F). £10 minutes per year.

GPS Receiver

The Global Positioning System (GPS) is based on 24 satellites, orbiting 20,000 km above the earth in
12-hour circular orbits. In order to make sure that they can be detected from anywhere on the Earth’s
surface, the satellites are divided into six groups of four.

Each group is assigned a different path to follow. This creates six orbital planes, which completely
surround the Earth.

These satellites send radio signals to Earth that contain information about the satellite.
Using GPS ground-based receivers, these signals can be detected and used to determine the receivers’
positions: latitude, longitude and height.

In the TruCAM, GPS is used to automatically set and synchronize the system time.

You need only set the local time zone and day light savings information (page 20).

The TruCAM is capable of receiving Satellite-Based Augmentation System
(SBAS) differential corrections in both Wide-Area Augmentation System
(WAAS) and European Geostationary Navigation Overlay Service (EGNOS).

Note: ﬁ

Although the GPS data is transmitted continuously, the following items
need to be considered:

1. The default GPS Interval setting is 60 seconds. This is designed for

maximum battery life.

2. You can change this value on the Device Parameters Screen (page 26).
3. A shorter interval will increase the GPS on-time, but will also reduce battery life.
4. A longer interval will decrease the GPS on-time and extend the battery life.

5. When GPS is locked in, the ﬁ icon appears at the top of the LCD Touch Screen and the real time
clock has been synchronized with the GPS.

6. When the GPS is not locked in, the time is from the internal TruCAM real time clock.

GPS receivers do not work well underground, inside buildings/tunnels, or if there is an obstruction to the
TruCAM.

Areas where there are tall buildings or dense strands of trees may also obstruct the signal.

13 © Tele-Traffic UK Ltd 2011



Serial Port

The serial port is located in the lower left corner of the rear panel.
It allows you to connect an external device to the TruCAM.

The serial port provides:

RS232 serial communication
RS485 night time flash signal
Auxiliary power supply for accessory items

Jam Detect

The TruCAM contains advanced circuitry and algorithms that allow
the instrument to determine if a laser jammer is potentially being used.

There are two possible situations:

1. You are targeting a strong light source such as xenon headlights.
-Or-
2. Atargeted vehicle is employing a laser jammer.

Regardless of the level of interference, you will never get an erroneous speed reading.
At a low level of interference, a speed may be captured or an EO3 error code may be displayed.
At a high level of interference, an EO7 error code will be displayed.

LCD Touch Screen
CAUTION:

To prevent damage to the Touch Screen, never use any device other than the stylus that comes with
the TruCAM to tap on the LCD Touch Screen. If your stylus is lost or broken, please contact Tele Traffic
UK Ltd to order a replacement stylus.

Some polarized sunglasses will block out the view of the LCD screen. This is related to the way light
interacts with the polarized lenses and is not a malfunction of the LCD Touch Screen. In this situation,
you may find it is beneficial to attach the Sun Shade (page 35) or adjust the LCD Backlight level see
page 16.

The LCD Touch Screen is located on the rear panel of the TruCAM. The LCD Touch Screen is 7 cm
(2.7 inch) QVGA colour and sunlight readable.

Your TruCAM comes with a stylus that you should use to tap on the screen. You can perform two basic
actions using the stylus:

Tap: Use the stylus to lightly touch the screen to select an item this is equivalent to clicking an item with
the mouse on your computer.

Double-tap to modify or open an option, item, etc. If the TruCAM does not respond properly to your
taps, the LCD Touch Screen may need to be realigned.

The Align Screen option is available on the Device Parameters Screen. See page 51 for information
about realigning the touch screen.
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Icons

The icons are the images that are displayed at the top of the LCD Touch Screen. The icons show such
things as the battery voltage level, LCD Backlight Level, Capture Mode, zoom factor, shutter speed, etc.
See page 65 for a list of the icons.

Toolbar Buttons and Soft Keys

The toolbar is located at the bottom of the LCD Touch
Screen. The available toolbar buttons vary with each
screen. Each screen contains 4 toolbar buttons.
There are 4 coloured soft keys on the TruCAM’s rear
panel, the colours correspond to the toolbar buttons.

=] - MR <«— [cons

As an alternative to tapping a toolbar button, you can
press the corresponding soft key. See page 67 for a
list of the toolbar buttons.

@ 0. "R
On-screen Keypad

Whenever alphanumeric data entry is required, the
TruCAM displays a set of keypads. As Figure 20
shows, the keypad is located at the bottom of the
LCD Touch Screen.

1928/248

Enabled

Enab led

5/e|78/98 M| < Back Space
FIMAEIRIEE) < Carriage Return

E <—— Space Bar

<«—— Keyboard Display

5617 ]8]9]8]-1=] [+
ritjylufijop|l]1|\]|+
glhljlkll]:]"]:]
T 'I' 14 T Extended
CV D m L A :
. T = Keyboard 1
. &

Upper Case, tap for lower case Extended Keyboard 2

Figure 20

The keypad is automatically selected by the Language option (page 21). Use the stylus to tap the
letters, numbers and symbols on the on-screen keypad to enter typed text directly onto the screen.

Tap or press the - soft key to save the current data and close the data entry message box.
Figure 20 (above right) shows Operators ID and the new data is “0559”.

Tap m or press the - soft key to adjust the intensity of the LCD backlight. See below.

Tap or press the D soft key to close the data entry message box without changing the current
data. Figure 20 (above left) shows Operator ID and the field is blank.
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LCD Backlight
You can vary the intensity of the LCD Backlight to account for different lighting conditions. The LCD

Backlight has five intensity settings. When the m toolbar button is displayed, tap it or press the -
soft key to adjust the intensity of the backlight. Tap repeatedly until the desired level is achieved.

0 =dim

1 = bright

2 = brighter
3 = default
4 = brightest

TruCAM Image Viewer

TruCAM Image Viewer is a software program that runs on a PC and allows you to view the motion clips
and still images. It is covered in Section 9 (page 54).
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Section 3 - TruCAM System and Information Screens

This section covers the screens that display system information and prepare the TruCAM for measuring
speeds and capturing motion clips / still images.

Powering ON the TruCAM

Press the Power button or pull and release the TRIGGER. The TruCAM Splash Screen appears briefly,
it should look like Figure 21.

Figure 21

Next the instrument’s microcontroller performs the Self Test.

If all tests prove positive, the Self Test Results Screen appears briefly, it should look like Figure 22.

VERSIOH
ICIee-1.19-7 / R2.8.10

SELF TEST
PRESED
BEROY TO WSE

Figure 22

Next the System Setup Screen is displayed (please Figure 24 on the following page).

If all tests do not prove positive, the appropriate error code will
appear. Figure 23 shows an example error message box. SELF TEST FAILURE
HIGH TEMPERATURE

If the Self Test indicates an error message: ERROR CODE [531

Press the Power button to power OFF the TruCAM.

Remove and re-insert the Battery Pack (page 8).

Power ON the TruCAM one more time to repeat the Self Test.

If the error repeats, power OFF the TruCAM. If the power source is not the problem, contact Tele Traffic
UK Ltd for assistance.

See the inside front cover for Tele Traffic UK Ltd contact information.
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If you want to go directly to the Capture Mode:

1. Pull the TRIGGER to start the Capture Mode.
2. Pull the TRIGGER a second time to activate the aiming reticule.

Otherwise, see below for information about the System Setup Screen.

Powering OFF the TruCAM

Press and hold the Power button for approximately 2 seconds. It will take approximately 10 seconds for
the operating system to shut down.

You can press and release the Power button to cancel the displayed screen. This is useful when the
toolbar button is not displayed.

Examples: Aligning the LCD Touch Screen or if the Capture Mode is active and you want to display the
System Setup Screen.

To help save its battery charge, the TruCAM has factory-defined power OFF intervals. The default
intervals are listed below.

You can change the power OFF intervals on the Device Parameters Screen (page 27)

Instrument: 10 minutes
LCD Backlight: 2 minutes
Camera: 1 minute
GPS Interval: 1 minute

System Setup Screen

When you power ON the TruCAM, the instrument will perform the Self Test (page 17). Upon successful
completion of the Self Test, the System Setup Screen is the next screen displayed.

Figure 24

» Changes to the System Setup Screen are not saved until you tap or press the D soft key.
* However, unsaved changes are valid until the TruCAM is powered OFF.
» If DBC is enabled, the System Setup Screen will include Roadside Offset option (page 40).

Use the stylus to select the option that you want to change. You can either double-tap the field, or tap
the desired field, and then tap or press the - soft key.

Once you have selected an option, you can tap or press the - soft key to scroll to the next option.
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LOCATION: Use the stylus and on-screen keypad to enter the required information up to a maximum of
8 Alphanumeric characters without any spaces. This should be entered at each location and each time
the unit is activated.

VIDEO MODE: Using the stylus, tap the Video Mode field to display the next value. Value = Still Image
Size / Motion Clip Size.

Video Mode Options Still Image Sizes Motion Clip Sizes
1920/240 1920 x 1440 pixels 240 x 180 pixels
1920/480 1920 x 1440 pixels 480 x 360 pixels
1440/240 1440 x 1080 pixels 240 x 180 pixels
1440/480 1440 x 1080 pixels 480 x 360 pixels

When selecting the Video Mode, you need to consider both image size and file size. Larger images
sizes provide more detail, but smaller image sizes require less space for data storage.

OPERATOR ID: Use the stylus and on-screen keypad to enter officer number or rank. Enter the
appropriate information to a maximum of 8 Alphanumeric characters without any spaces. It is advisable

that this data field be updated and saved on each occasion the device is used by another operator
as this information appears on the prosecution file image. Factory Default = 23456.

CAPTURE SPEED: The Capture Speed Limit is the capture threshold for an image. The TruCAM will
only capture an image when the vehicle’s measured speed is equal to or greater than the Capture
Speed Limit. Use the stylus and on-screen keypad to enter the required information.

* MPH: 0 -200

VIDEO TRACKING MODE: When this mode is enabled, you can measure the speed of a distant target
vehicle and store a motion clip. While continuing to pull the TRIGGER and keeping the aiming reticule
aimed at the target vehicle’s Licence plate. The still image of the vehicle is captured once the vehicle
reaches the camera focus range.

» The distance value is the camera focus distance where the still image capture will occur.

* Use the stylus and on-screen keypad to enter the required value.

* Range = 15 - 150 metres

» Default value = 70 metres

« Use the stylus to Enable or Disable this mode. When this option is disabled, the still image is
captured when the speed is measured. Image quality may be poor if the target vehicle is not in the
camera focus range.
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MEMORY USAGE:

Use the stylus to tap the spot indicated on the screen (“tap here”) to display memory usage.

(See Figure 25.) As shown in the figure, a message box will be displayed briefly. In this example
Free Space = 3742 MB and the 4GB SD Card is approximately 1% full. See page 71 for information
about SD Card requirements.

English

" @

Figure 25

The number of files that can be saved on each SD Card depends upon the SD Card size, the image
size selected, and the length of the video captured for each file. For a 4 GB SD Card, the average is
approximately 2,000 files stored.

Date & Time: [GPS] Current date and time. The date format can be changed on the Device Parameters
Screen (page 26). Using Figure 25 as an example, the screen image was captured on Tuesday, 4
January 2011 at 05:45:15 AM.

When you receive your TruCAM, the date and time may not match your location. It is easy to set the
clock, but it does require some knowledge about time zone and daylight savings (summer) time.

You will need to know:

* The United Kingdom uses the Greenwich Mean Time or (GMT) which has a 00 factor on the world
time chart.

» Does your location use daylight savings time? If yes, what are the start and end dates for daylight
savings time?

You can obtain additional information on this by using a computer with Google and entering
“Coordinated Universal Time” or contact Tele Traffic UK Ltd.

See inside front cover for Tele Traffic UK Ltd contact information.
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To change the Date & Time:

1. Use the stylus to double-tap the current date and time. As Figure 26(A) TINE ZOME & OS]
shows, a message box will be displayed, prompting you to enter the SET CLOCK

Password Required

required user password.

2. Use the stylus and on-screen keypad to enter the user password. The
default user password is ‘admin’. To change the user password, see

page 43.

If you cannot remember current user password, contact Tele Traffic TIHE 20HE & DST
UK Ltd for assistance. See inside front cover for Tele Traffic UK Ltd B e
contact information.

A message window will be displayed that includes the current setting. As
an example, Figure 26 (B) shows the information for the United Kingdom.

* 00.00 = The United Kingdom 00.00 offset from UTC or GMT
* 03:4 (MM:W) = For 2011, daylight savings time starts the 4th Sunday in March (3rd month).
* 10:4 (MM:W) = For 2011, daylight savings time ends the last Sunday in October (10th month).

3. Use the stylus and on-screen keypad to enter the information for your location.
When done, tap or press the - soft key:
+ If there are no errors, you will hear a good tone and the System Setup Screen will be displayed.

***The change is not immediately displayed. The Date & Time is only updated when the GPS has a
fix. In most cases you will have to be outside and cycle the TruCAM OFF/ON.

If there is an error, an error message will be displayed and it may look
similar to Figure 26(C).

THE Z0HE & DS
Format Error
+HH .HH ,HH :H HH :H

Tap OK and try entering the information again. OK

Figure 26 (C)

* Tap or press the D soft key to cancel without changing the
date and time.

LANGUAGE:

The default Language is English and this will be the only language available for the United Kingdom
version of TruCAM. (default).

For more information about language availability, contact Tele Traffic UK Ltd.
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Icons at top of the LCD Touch Screen.

See page 65 for information about the icons that appear at the top of the LCD Touch Screen.

Tool Bar Buttons at the Bottom of the LCD Touch Screen

Function

Button Soft Key

Toolbar ‘ Alternative ‘

Tap to enter the Test Mode. The Scope Alignment Test (page 46)
will be the first screen displayed.

E
O

This button is displayed only after you select an option. Tap to
scroll to the next option that appears on the screen.

Tap to select the option that you want to change.

Tap to change the brightness of the LCD Backlight (page 16).

Tap to enter Playback Mode (page 43). The most recent image
will be displayed.

el
08 B 0

c

System Options Screen
To display the System Options Screen:

From the System Setup Screen, tap and then or press the -
soft key and then the - soft key.

B meter

Changes are not saved until you tap the or press the D soft key. o
However, unsaved changes are valid until the TruCAM is powered OFF. Display

Change

Use the stylus to select the option that you want to change. You can either

double-tap the field, or tap the desired field, and then tap or press L T

the - soft key ® (J‘ '
4 Y/, v

Once you have selected an option, you can tap or press the -

soft key to scroll to the next option.

Classic Proceed

© Tele-Traffic UK Ltd 2011
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MEASUREMENT UNITS: This option is factory-set and appears as display only. The TruCAM is factory
locked for the UK and will display MPH and metres.

CAMERA LENS FOCUS: Select to change the distance where the still image capture will occur during
Speed Mode. Displays message box and on-screen keypad prompting you to enter the new value:

* The range = 50 - 150 metres
* The optimum and default value = 70 metres

DEVICE INFORMATION: Double-tap “Display ...” to display the Device Information Screen (page 25).
DEVICE PARAMETRES: Double-tap “Change ...” to display the Device Parameters Screen (page 26).

CROSSHAIR: Use the stylus to select the crosshair style that will be displayed on vehicle images.

Classic (default) = BE and Beam Size =

FS CHECK: FS CHECK stands for Linux File System Check and Repair. Double-tap “Proceed” to
check the integrity of the SD Card file system.

In the United Kingdom version the TruCAM Splash Screen appears, if the check is successful the unit
will switch off the power.

U LASER
-] lfF_(_J HNOLOGY

g & g ¥ (=ANA

Peraserma oy Lo A
Figure 28

Figure 28 shows the screen that will be displayed during the check.

If necessary, the TruCAM is able to recover (repair) a damaged file system on the SD Card. The
TruCAM will automatically start the FS Check if (1) the SD Card is accidentally rejected, (2) the battery
pack is removed during use, or (3) the SD Card contains logically damaged files.

» The toolbar buttons are not active during the check.
* Do not press the Power button during the check.
* The TruCAM will power OFF when the check is complete.

« If the SD Card is damaged, any recovered files will be located in the SD Card’s root directory with an
*.rec file extension.

» With a logically damaged SD Card, some data or entire data may be lost.

© Tele-Traffic UK Ltd 2011
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LICENCE MANAGER:

The Licence manager is used to install additional software features on
your TruCAM. For example, if you purchase DBC some time after receipt
of your TruCAM, to activate the DBC feature you would enter a unique
Licence Code into the Licence Manager.

ENSE HANRGER

If the Licence Manager Tab is double tapped it will prompt you to enter a t Enter the code
code as in Figure 29. |

Change ...

12|3/4(5|6|7 8/9(B

In most cases within the United Kingdom no additional features would be gluleleitlylulle plLTN
a5 o TLUEP BL

permitted under the HMG Home Office Type Approval Licence. Contact zTx[c[w]b]n ] 7
Tele Traffic UK Ltd for further information regarding this manager. @ 9, ®

Figure 29

Icons at top of the LCD Touch Screen

See page 65 for information about the icons that appear at the top of the
LCD Touch Screen.

Tool Bar Buttons at the Bottom of the LCD Touch Screen

Toolbar Button Function

Soft Key

Alternative ‘

C

Tap to scroll to the next option that appears on the screen.

This button is displayed when a message box is displayed,
prompting you change value associated with an option. Tap to close
the message box and accept the value that you entered.

el

Tap to select the option that you want to change.

Tap to change the brightness of the LCD Backlight (page 16).

B0

Tap to save changes and return to the System Setup Screen
(page 18).

C

This button is displayed when a message box is displayed,
prompting you to change value associated with an option. Tap this
button to close the message box without changing the value.

0 D80 8

™
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DEVICE INFORMATION SCREEN il 4 T Ty

To display the Device Information Screen: bl TEi8-1.10-7 7 R2.8.18
On the System Options Screen, double-tap 7 il >

AL AN
TCHBB404 / BRRBBE?

“Display .” that appears just below DEVICE ERTEST
INFORMATION. - (61 PRSSED ey

Disp oy #1 Tue Jan 13 B9:32:38 2889

1‘:I|.-\|||;|' - f.I'FFI[I DELC
VERSION: TruCAM model, package and ' ' :
firmware version number. ICERSE HRHAOER RST FLIGHENT CHECK
In this example: TC100-1.19-7 / R2.8.18 i R

® @ e, %@

System Options Device Information
Screen Screen

Figure 30

* Model = TC100 = TruCAM 100
* TruCore Version = 1.19-7
 TruCAM Version = R2.8.18

SERIAL AND FILM NUMBER:
» Serial Number: The serial number of your TruCAM. In this example = TC0000484.

* Film Number: 7-digit sequence number that is increased by ‘1’ each time a *.jmf file is saved to
the SD Card.

* The Film Number is not related to any particular SD Card. The information associated with the
Film Number counter resides on the TruCAM and cannot be reset. In the Film Number = 0000002
(The TruCAM with serial number TC000484 has stored a total of 2 *.jmf files)

The last 3 digits of the Film Number are displayed during Capture Mode (page 36) and Playback Mode
(page 43).

If the Battery Pack is accidentally removed or the SD Card is rejected while a *.jmf file is being saved,
the Film Number may be not increased. The folder will have two *.jmf files that have the same Film
Number and the first file will be damaged.

SELF TEST: Displays the results of the power ON Self Test.

* [0] Indicates that all tests proved positive.
« If all tests do not prove positive, the appropriate error code will appear in this field. For more
information about Error Codes, see page 64. Example: E52 = temperature too low.

LINUX: Operating system version number and information.
LICENCED FUNCTIONS:

Licensed programs that are active in your TruCAM

» Default: SPEED: includes Speed Mode, Rear Plate Mode, Video Only Mode, Weather Mode, Night
Mode (requires additional hardware)

* Available Options: DBC

INSTALLED DEVICES: Displays the devices that are installed in your TruCAM.
RTC = Real Time Clock GPS = Global Position System Receiver

© Tele-Traffic UK Ltd 2011
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LAST ALIGNMENT CHECK: Displays the date and time of the last Scope Alignment Test (page 46).
Minimum of 5 test tones / TRIGGER activations

Icons at top of the LCD Touch Screen

See page 65 for information about the icons that appear at the top of the LCD Touch Screen.

Tool Bar Buttons at the Bottom of the LCD Touch Screen
The - and - soft keys are not active.

Function

Button Soft Key

Toolbar ‘ Alternative ‘

m - Tap to change the brightness of the LCD Backlight (page 15).

D Tap to return to the System Options Screen (page 22).

DEVICE PARAMETRES SCREEN
Changes are not saved until you tap or press the D soft key. However, unsaved changes are

valid until the TruCAM is powered OFF.

Vo A—0O = Gl e O & ulew On the System Options Screen, double-

o g — o3 tap “Change ...” that appears just below

DEVICE PARAMETERS

lllli.uaq; on DO nnw-vr Use the stylus to select the option that you
b, x b want to change. You can either double-tap

, REE} the field, or tap the desired field, and then

P et tap - or press the soft key.

Classic Procesd Change . .

Ertar G oude i Disabled Once you have selected an option, you

® @'e = ® @', a i can tap {EB or press the [ soft key to

scroll to the next option.

CE IHi I
Display 24 per W 4 per

System Options Screen Device Information Screen

Figure 31
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POWER OFF TIMER: Instrument power OFF interval. The instrument will automatically power OFF if
there is no activity for the specified time interval. Instrument activity includes any taps on the LCD Touch
Screen, button presses or serial communication. Use the stylus and on-screen keypad to enter the

desired time interval.

POMER OFF TIMER
Range Error
From 388 to 7288 sec

0K

Figure 32

Range = 300 to 7,200 seconds

Default = 600 seconds

Entering a value that is invalid, displays a range error
message (Figure 32). Tap OK and then enter a valid value.
The Power OFF timer is disabled when Auto Mode is active.

BACKLIGHT: LCD Backlight power OFF interval. The LCD backlight will automatically power OFF if
there is no activity for the specified time interval. Instrument activity includes any button presses or

serial communication.

BACKL IGHT
Range Error
From 38 to 7288 sec

DK

Figure 33

Use the stylus and on-screen keypad to enter the desired
time interval.

Range = 30 to 7,200 seconds

Default = 120 seconds

Entering a value that is invalid, displays a range error
message. Tap OK and then enter a valid value.

CAMERA POWER: Camera power OFF interval. This is the time in seconds that live video is displayed

without any activity while in Speed Mode.

CAMERA POMWER
Range Error
From 28 to 6HB sec

OK

Figure 34

Use the stylus and on-screen keypad to enter the desired
time interval.

Range = 20 to 600 seconds

Default = 60 seconds

Entering a value that is invalid, displays a range error
message. Tap OK and then enter a valid value.

When the camera times out, the live video will be suspended.

The image shown in Figure 35 will flash.

Pull the trigger to activate camera.

]
WM

o o] 4

. Aeee 0 -

Figure 35
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GPS INTERVAL.:

The GPS does not sense location continuously. Based on this Range 5 to 128 sec
time interval, the GPS will wake up, sense the current date, @ = Always on
time, location, update the system, and then shut down. The 999 = Disabled
default interval is 60 seconds. Use the stylus and on-screen
keypad to enter the desired time interval. Figure 36 shows the

message box that will be displayed.

* Range =5 to 120 seconds

* Entering a value that is invalid, displays a range error message. Tap OK and then enter a valid value.

» Example: When the interval is set to 60 seconds, the GPS sensor will sense and update the location
every 60 seconds.

DATE FORMAT:

Selectable date format. Use the stylus and on-screen keypad to toggle the value.

* YYYY/MM/DD (default)
- MM/DD/YYYY
- DD/MM/YYYY

FRAME RATE and TRACK STORAGE:

Default values are based on the Video Mode selection (System Setup Screen, page 18). Changing the
Frame Rate automatically adjusts the Track Storage. Use the stylus or the soft keys to toggle the Frame
Rate and Track Storage values. Track Storage may be changed independently of the Frame Rate.

FRAME RATE:

The frame rate is selectable prior to any measurement being made and based on motion clip size selection
in the menu below. Use the stylus to toggle between the possible values listed in the table below. This
selection effects *.jmf file size. Larger number frames per seconds will result in larger *.jmf files.

240x180 pixels 480x360 pixels

Coarse Motion Clip Mode Fine Motion Clip Mode

Typical # Frames/jmf file = 250 Typical # Frames/jmf file = 125

Frame Rate 24 Frame Rate 14

(per second) 18 (per second) 1"
12 9
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TRACK STORAGE:

Selectable frame storage after the measurement and based on the current Frame Rate.
Use the stylus or the soft keys to toggle the value. Possible values are listed below.

» approximately 1/3 of the Frame Rate

* same as the Frame Rate

» approximately 1/6 of the Frame Rate
This selection effects *.jmf file size. Larger number of tracks stored will result in larger *.jmf files.

The equations below can be used to estimate Tracking Time and Tracking Distance.
Tracking Time (seconds) = (typical # frames - 2 * Frame Rate) / Track Storage
Tracking Distance = Vehicle Speed * Tracking Time

Example: Coarse Motion Clip, Frame Rate = 24 frames/second, Vehicle Speed = 30 mph = 13.41 m/sec
Tracking Time = (250 frames - 2*24 frames/second) / 8 frames = 25 seconds
Tracking Distance = (13.41 metres/second * 25 seconds) = 335.25 metres

ALIGN SCREEN: See page 51.

PASSWORD:
Follow the steps below to change the user password.

1. Use the stylus to double-tap “Change...” to change the user password. Figure 37 shows the message
box that will be displayed.

2. Use the stylus and on-screen keypad to enter the current user password.

3. Use the stylus and on-screen keypad to enter the new password:
Minimum = 5 characters and maximum = 23 characters.
Figure 38 shows the message box that will be displayed.

4. Use the stylus and on-screen keypad to re-enter the new user password (Figure 39).
- If new user password passes verification, the Device Parameters screen will be displayed.
- If the new user password fails verification, an error message displays. Tap OK. The Device
Parameters Screen will be displayed. Repeat the above steps.

Tap or press the D soft key to cancel without changing the user password.

PASSHORD New Password Hew Password
Use alphanumeric code Use alphanumeric code
Passuord Required Hinimum 5 chars Verification

Figure 37 Figure 38 Figure 39

RESET SETTINGS:

* The default user password = admin

+ Resetting the factory default settings restores the default user password.
 If you cannot remember current user password, contact Tele Traffic UK Ltd.
» See inside front cover for Tele Traffic UK Ltd contact information.
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Icons at top of the LCD Touch Screen

See page 65 for information about the icons that appear at the top of the LCD Touch Screen.

Tool Bar Buttons at the Bottom of the LCD Touch Screen

Button Function

Toolbar ‘ Alternative ‘

Soft Key

@

@

Tap to scroll to the next option that appears on the screen.

This button is displayed when a message box is displayed,
prompting you change value associated with an option. Tap to
close the message box and accept the value that you entered.

0

Tap to select the option that you want to change.

Tap to change the brightness of the LCD Backlight (page 16).

Tap to save changes and return to the System Setup Screen
(page 18).

This button is displayed when a message box is displayed,
prompting you to change value associated with an option. Tap this
button to close the message box without changing the value.

C &0
0,088 B8
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Section 4 - Roadside Laser/Camera Setup

Choosing a Roadside Location

When choosing a spot on the side of the road for measuring moving vehicles, you will need to consider:
Is the location safe?

Do you have a clear line of sight?

What is the approximate angle between the instrument’s position and the target vehicle’s direction of travel?
What is the approximate distance to the target vehicles?

How is the weather? Will you need to use the Weather Mode?

Where is the sun located? Ideally, it is best to setup with the sun on your back, behind the Camera. This
ensures the Licence plates and the LCD Touch Screen are both illuminated as much as possible. It is

also acceptable to setup with the sun to your left or right. Setting up with the Camera aimed directly into
the sun is not recommended and will not result in good images.

The optimum targeting distance is 70 metres, but good illumination and focus can increase this
distance. Conversely, there is less natural light available on cloudy days so it may be necessary to
decrease the targeting distance.

Hand-held: 15 - 80 metres
Tripod mounted: 15 - 90 metres
Line of Sight

Ideally, you should have a clear line of sight to the target vehicle.

If there is a momentary break in the laser measurement beam, the instrument will accumulate data and
may be able to capture the target vehicle’s speed. The instrument will display an error message if it
cannot capture the target vehicle’s speed.

If there is an extended break in the laser measurement beam, the instrument will display an error
message.

The Cosine Effect

If the target vehicle is moving directly toward or away from you, the speed measured by the TruCAM is
identical to the vehicle’s true speed. However, the instrument is usually set up on the side of the road
for safety. This results in an angle between the instrument’s position and the target vehicle’s direction
of travel. When the angle is significant, the measured speed is less than the target’s true speed. The
phenomenon is known as the cosine effect. Cosine is the trigonometric function that relates to this
phenomenon.

The difference between the measured speed and the true speed depends upon the angle between the
instrument’s ideal position, the position where targets would be moving in direct line with the instrument,
and its actual position.

The larger the angle, the lower the measured speed.
The effect always works to the motorist’s advantage.
Loosely speaking, the cosine effect is not significant as long as the angle remains small.
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Measured Speed by Angle: The Cosine Effect:

IMPERIAL

True Speed
Angle 30MPH | 40MPH | 50MPH | 60MPH | 70MPH
(degrees)
Measured Speed (MPH)
0 30.00 40.00 50.00 60.00 70.00
1 29.99 39.99 49.99 59.99 69.99
3 29.96 39.94 49.93 59.92 69.90
5 29.89 39.85 49.81 59.77 69.73
10 29.54 39.39 49.24 59.09 68.94
15 28.98 38.64 48.30 57.94 67.61
20 28.19 37.59 46.99 56.38 65.78
45 21.21 28.28 35.36 42.43 49.50
90 00.00 00.00 00.00 00.00 00.00

The cosine effect decreases as the range to the target vehicle increases.

At the maximum range of the instrument, the vehicle is so far away that the angle between it and the
instrument is very small indeed. The instrument’s perception of the target’s speed is identical to its true
speed.

As the vehicle approaches, the angle increases until it becomes large enough to affect the measurement.

To minimise the cosine effect, keep the angle small. Set up the instrument as close to the road as
possible without creating safety risks, and target down the road at ranges sufficient to keep the angular
difference small.

The table below shows acceptable parameters for minimising the cosine effect. The chart indicates the
percentage of true speed measured, given the distance from the roadway and the distance from the
target vehicle. To find a target’s measured speed, multiply the true speed by the number in the chart.

METRIC

Distance off Range to Target Vehicle
the roadway 30 m |  100m | 150m | 300m | 600m
(metres) Fraction of the True Speed that will be measured

3 .9950 .9995 .9998 .9999 1.0000
10 .9682 .9950 .9987 .9997 .9999
15 .8660 .9886 .9950 .9987 .9997
30 .0000 .9539 .9798 .9950 .9987
60 .0000 .7999 9165 .9798 .9950

As a general rule:

METRES: Do not exceed 1 metre off the road for every 10 metres shooting down range to the targets.
If target vehicles will be 150 metres down the road, set up no more than 15 metres off the road.

Remember that the cosine effect is always in the motorist’s favour.
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Adjusting Camera Settings

The Camera’s default settings are set for optimum results in a typical situation. You may need to adjust
some settings based upon your preference or current location.

Depth of Field

The depth of field (DOF) is a unit of measurement
that represents the range of distances within an
image where the focus is acceptably sharp. This is
the distance in front of and beyond the subject that
appears to be in focus. The DOF is determined by
the subject distance, the lens focal length and the
lens F-stop. On the TruCAM, you cannot change the
distance and the lens focal length, so only the F-stop
is variable. The TruCAM is able to adjust gain in

accordance of the_aperture. During a capture session,
a larger f-number is better.

The two images to the right have the same focus, but the f-number of Figure 40(A) is 2.8 and Figure
40(B) is 16. In Figure 40(B), the DOF is much greater. In Figure 40(B) the fine branches of a small tree
a sort distance in front of the lasers camera now become visible.

Practical Note: At the time image Figure 40(B) was captured the light was very poor. To highlight
the effect of Depth of Field the F16 f-stop had to be used. As with any type of camera if a high F-stop
is employed and the light is insufficient the image takes on a dark graining effect as shown in this
example. If your images are dark with graining readjust the F-stop to clear the effect.

Iris

Iris is an adjustable aperture used to control the amount of light coming through the lens. The more
the iris is opened, the more light it lets in and the brighter the image will be. Aperture is the unit of
measurement that defines the size of the opening in the lens that can be adjusted to control the
amount of light that reaches the digital sensor. The size of the aperture is measured in F-stop. The Iris
Adjustment Ring may be positioned on an F-stop or anywhere in between two F-stops.

In any type of environment, maintain the biggest f-number possible.
The smaller the f-number, the bigger the opening (more light).
Typical value on cloudy or foggy day = 8 to 11.

The bigger the f-number, the smaller the lens opening (less light).
Typical value on sunny day = 11 to 16.

Automatic Gain Control
Automatic Gain Control (AGC) optimises picture quality at all times during the day. It increases the

video signal at low light levels to make the picture brighter. If the majority of the image is dark, AGC
will adjust the entire image to make it more easily viewable.

This option is available during the Capture Mode. Tap or press the - soft key to toggle
AGC ON or OFF.

If the Resc toolbar button is not displayed, tap or press the D soft key.

ON: The [ icon is displayed at the top of the LCD Touch Screen and AGC electronically adjusts the
camera to the proper light level.
OFF: The [ icon is not displayed at the top of the LCD Touch Screen.

AGC cannot compensate for all lighting conditions and typically must be used in conjunction with an
adjustment of the lens iris.
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Camera Lens Focus Distance

During assembly, the Camera is focused for 70 metres.
This setting provides sharp images from 50-150 metres.

Pull the TRIGGER to start the Capture Mode. .,,ﬁ‘er VAR
— LN
Tap or press the D soft key twice to display [ | U . IL-L\,". 5 \1
and then tap or press the - soft key to use 208! | “g.’//
the zoom function to optimise the view. Ty . Adiustment ring

Locate a target with defined lines on it. A street sign “\ i I;is Adjustment ring
is ideal. The target should be at the Video Tracking L .

Distance set on the System Setup Screen.

e

-

Open the Camera Cover to access the Focus

Adjustment Ring and the Iris Adjustment Ring.

Figure 41 refers.

Aim the TruCAM at the target and adjust the lens iris for the best amount of light entering the camera.

Focus the Camera so you can easily read the target vehicle’s Licence plate and readily recognise the
surrounding roadway.

Hand-held: 15 - 80 metres
Tripod mounted: 15 - 90 metres
Shutter Speed

Shutter speed is the length of time that the shutter remains open as the image is captured, and is very
critical for image quality. Choose faster speeds as much as possible. The shutter speed and aperture
together control the total amount of light reaching the sensor. Shutter speeds are expressed in fractions
of a second. Lower shutter speeds provide larger F-stop number, and in turn result in a larger DOF.

Shutter speed may not be displayed during Playback Mode.

This option is available during the Capture Mode. Tap m or press the - soft key to change the
shutter speed.

The current shutter speed is displayed at the top of the LCD Touch Screen. See page 65 for information
about the icons that appear at the top of the LCD Touch Screen.

The actual shutter speed is inversely related to the speed value displayed, so to increase the shutter
speed you would select a smaller setting.

Range: 2K0 = 1/2000 second (bright day) to 200 = 1/200 second (dark day)

200 is suitable for dark environments.

400 is suitable for lower speed zones.

600 is suitable for faster speed zones.

Higher shutter speeds may be suitable for bright environments and test/alignment.
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Attaching / Removing the Shoulder Stock

The Shoulder Stock helps stabilise the TruCAM and is
designed for either left-handed or right-handed use.

Attaching the Shoulder Stock

1. Rotate the Shoulder Stock Release toward the front of
the TruCAM.

2. Align the pronged-end of the Shoulder Stock with the
Shoulder Stock Attachment Point as shown in Figure 42.

3. Slide the Shoulder Stock straight into the two holes.

4. Rotate the Shoulder Stock Release toward the rear of
the TruCAM to secure the Shoulder Stock.

Removing the Shoulder Stock

1. Turn the Shoulder Stock Release toward the front of
the TruCAM.

2. Continue to hold the Shoulder Stock Release in this
position.

3. Pull the Shoulder Stock straight toward you. See Figure 43

Attaching the Sun Shade

1. Align and insert the two large tabs on the back of the Sun
Shade with the two slots above the LCD Touch Screen.

2. Press down and rotate the cover into position until the
pegs lock on the notches located one on each side of the
LCD screen.

Attaching / Removing the Sun Shade

Your decision to use the Sun Shade may depend on weather
conditions. You may find it useful on bright, sunny days.

Removing the Sun Shade

Expand the sun shade slightly to release the pegs from the
notches as in Figure 45.

Pegs ‘i 3
(1 each)

Slots (2)

Notches - (AT )
(1 each side)

Expand slightly to ;JL
release the pegs ~| G,
from the notches LY, o ]L-}

(e
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Section 5 - TruCAM Capture Modes

During the capture session. During the capture session, you should monitor the following items:

Battery Charge. It is recommended that the TruCAM be charged to the maximum prior to any field
acquisition. See page 9 for information about the Battery Voltage Icon.

File Space Available on the SD Card for Additional Images. This information is available on the
System Setup Screen (page 18). During the capture session, briefly press the Power Button to display
the System Setup Screen and then double-tap the area indicated as “Tap here” to the right of Memory
Usage. For a 4 GB SD card, the average is approximately 2,000 files stored.

Image Quality. During the capture session, changing weather conditions or location of the sun may
affect image quality. If the image quality is not optimum, it may be necessary to adjust camera
settings (page 33).

Toolbar buttons that appear at the Bottom of the LCD Touch Screen.

Toolbar Alternative .
Function

Button Soft Key

- Playback Mode (page 43). The most recently captured image will
be displayed.

z

Video Only Mode (page 39)

Rear Plate Mode (page 39). This button is only displayed when the
Video Only Mode is active.

Speed Measurement Mode (page 37)

Tap to advance to the next three options on the Capture Session
Toolbar.

Tap to adjust Shutter Speed (page 34).

Tap to adjust the intensity of the aiming reticule and HUD (page 10).

Tap to adjust the intensity of the LCD backlight (page 16).

Night Time Mode. Hardware requirements apply. This manual does
not cover this mode, it is covered in a separate document.

DERELCNE D

Weather Mode (page 38)

Zoom Function. Tap to enlarge detail of the displayed image.
Coarse Motion Clip Mode includes normal display and 3 levels of
zoom (page 65). Fine Motion Clip Mode includes normal display
and 1 level of zoom (page 65).

»
+

B8 BeeER0O N B

Rec Tap to toggle AGC ON or OFF (page 33).
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Speed Mode

Speed Mode is the default capture mode. When this mode is active the EJ BEE nzeeE e bl G
icon is displayed at the top of the Touch Screen as Figure 46 shows.

If another feature of the Capture Mode is active, tap = or press the -
soft key to start the Speed Mode.

1. Select your location and adjust the camera settings
(Section 4 Roadside Setup).

2. Power ON the TruCAM.

3. Use the aiming reticule to aim the instrument at the target vehicle’s —
Licence plate and pull the TRIGGER.

4. Continue to pull the TRIGGER and keep the instrument sighted on the target.

* Alow-pitched growl means that the instrument is attempting to lock onto the target.

* Alow-pitched beep means that a measurement error occurred. An error message will be displayed
(page 64).

* A high-pitched single beep means that a speed was captured. The measured speed will be displayed
on the LCD and projected in the scope just below the aiming reticule.

While the instrument is attempting to lock onto the target, as long as the TRIGGER is kept pressed, it
will retry the speed measurement.

* The instrument will attempt to lock onto the target for up to 5 seconds. Information is accumulated
until it gets a good measurement or generates an error message.

» Consequently, it is very important that the aiming point on the target remain constant for the entire
measurement time. If you move the instrument off the aiming point, it will generate an error code
instead of capturing a speed reading.

If Video Tracking is enabled (page 19), when the target vehicle reaches the specified distance, the
camera will capture the still image of the vehicle.

Video Tracking will stop if you move off the target, the laser measurement beam is interrupted, or the
maximum file size is exceeded.

If Video Tracking is disabled, the still image is captured when the speed is measured. Image quality
may be poor if the target vehicle is not in the camera focus range.

After you release the TRIGGER, the instrument will display the speed reading and the distance at which
it was captured or an error message.

* The speed displays as a negative number if the target was going away from you when it was measured.
* The speed displays as a positive number if the target was approaching you when it was measured.

The TruCAM will compare the measured speed to the Capture Speed Limit (System Setup Screen,
page 18).

+ If the measured speed is greater than or equal to the Capture Speed Limit, the motion clip / still
image and the related measurement data will be saved to the SD Card.
» If the measured speed is less than the Capture Speed Limit, no data is saved to the SD Card.

5. Repeat steps 3 and 4 to capture each additional speed measurement motion clip / still image.
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Weather Mode

Moisture is reflective. Weather such as rain, snow, mist, spray or fog can make it difficult for the laser
to receive signals back from the target vehicle. This is especially true when you are trying to capture
speeds at close range. The TruCAM includes a built-in Weather Filter that, when it is active, it is applied
when the laser is fired.

When the Weather Mode is active, the factory-defined gate setting increases the instrument’s minimum

range from 20 metres to 61 metres. Increasing the minimum range ensures that the laser only acquires
targets beyond the range where weather affects the laser’s ability to capture a speed reading.

When this filter is active:

1. The m icon is displayed at the top of the Touch Screen as W nzool e e Sl 02
Figure 47 shows.

2. Targets must be a distance greater than 61 metres.
3. The instrument’s maximum range is not changed.

4. Other than the above items, the TruCAM operates the same as when
the Weather Mode is not active.

OMPH
To activate the Weather Mode 28.1 m
1. Ensure that the TruCAM is powered ON and that the Capture Mode is C:/®10+T®

actve.

2. Tap @ to display the other options on the Caption Session Toolbar.
3. Tap g or press the . soft key to activate the Weather Filter.

4. Proceed with making a normal speed measurement as described on
the previous page.

s AZeaE] (O]

Rear Plate Mode

Rear Plate Mode can be used when targeting an approaching motorcycle
or other vehicle that does not have a front Licence plate.

The process of measuring the speed and distance is the same as in
the Speed Mode. The difference is that in this mode, after the speed oemesez 14/B1 2811 13:31:63
measurement has been taken, continue to hold the TRIGGER and track ot oty

the vehicle as it passes. |
B 90

Figure 48

Keep the camera on the target until it is on the rear Licence plate and then
release the TRIGGER. The still image is captured when you release the

TRIGGER.

When this mode is active the icon is displayed at the top of the LCD Touch Screen as Figure 48
shows.

To start the Rear Plate Mode, tap or press the - soft key.

* Image quality may be poor if the target vehicle is not in the camera focus or range when you release
the TRIGGER.

* In this mode, target vehicles will always be approaching, therefore, all measured speeds will be
positive values.
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Video Only Mode

When this mode is active, the TruCAM captures video images only.

The icon @ is displayed at the top of the Touch Screen and D
appears just above the toolbar buttons as Figure 49 shows.

To start the Video Only Mode, tap or press the - soft key.
Since speed measurements are not captured, pressing the TRIGGER
does not fire the laser.

1. Power ON the TruCAM.

2. Start the Video Only Mode.

3. Use the aiming reticule to aim the instrument at the target and pull
the TRIGGER.

4. Continue to press the TRIGGER and keep the instrument sighted
on the target.
Video will be captured as long as you hold the TRIGGER.

ULl

o AZea(E] (O] ol W7

148172811 14:42:14

b

B %o

Figure 49

Maximum recording is up to 2 minutes or 8 MB, whichever occurs first. Since the *.jmf file includes the
image data and file header information, the actual file size may be larger than 8 MB.

Distance between Cars (DBC)

DBC is defined as the “back-to-front” bumper separation
between two vehicles (see figure 50). In DBC Mode, you
aim the TruCAM at the first (leading) vehicle, take the
measurement, aim at the second (trailing) vehicle and take
the measurement. The DBC results are displayed at the
bottom of the LCD Touch Screen.

—
DBC

Figure 50

Selecting a Location

Since it is not possible to directly measure the back-to-front separation, a back-to-back or front-to-front
measurement is made and used to calculate the displayed DBC value. This approach biases the DBC
value in favour of the trailing vehicle by the length of the leading (or trailing) vehicle.

1. Select a safe location preferably

at the side of the road. Approaching

2. Make sure you have a clear line A e
of sight. m}\““-:-.,_ -

3. Make sure that you have enough T
distance to visually track the C

vehicles before measuring the
DBC with the TruCAM.

Departing

Figure 51

As shown in Figure 51, your measuring position may be in front of the lead vehicle for approaching

traffic or to the rear of the trailing vehicle for departing traffic.

To optimise the measurement geometry for the best possible results, the DBC measurement sequence

should be to the lead vehicle first and then to the trailing vehicle.

39
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Roadside Offset

The Roadside Offset is equal to the distance from the location where you
are taking the DBC measurement to the mid-point or centre of the road
where the vehicle is travelling.

The offset is used to eliminate any bias in the DBC calculation due to the -
cosine effect (page 31). 95 neter  Enobled
i-'fl; 1/ }-;‘H ]-I H-I'l]-il r
As Figure 52 shows, when DBC is enabled the System Setup Screen e gy
includes a Road Offset value located in the bottom right corner. e
“A'@ e, B
When entering the Roadside Offset, keep in mind that the minimum

capture distance is a 2.5-to-1 ratio.

» Example: If your Roadside Offset is 10 metres, the minimum capture distance to either target vehicle
would be 10 metres x 2.5 = 25 metres.

Use the TruCAM to measure the Roadside Offset Distance or manually enter the Roadside Offset Distance.

* The default value is 5.0 metres.
» Manual entry: valid range limit between 1.0 and 100.0 metres.
* Previous Laser entry range limits for minimum range recording are ignored.

Changes to the System Setup Screen are not saved until you tap or press the D soft key.

However, unsaved changes are valid until the TruCAM is powered OFF.

Entering the Roadside Offset:

Use the stylus or the soft keys to select the Roadside Offset. Figure 53 shows the message box that will
be displayed.

Using the Laser to Measure the Roadside Offset Distance:

1. Select the “Laser Measure” option:
Use the stylus to tap the [1] field in the message box, tap the - button, or press the - soft key.
The screen should similar to Figure 54 (left).

2. Aim to the centre of the lane of travel and press the trigger. The measured distance will be displayed
at the bottom of the screen as Figure 54 (right) shows.

3. Tap the or press the - soft key to save this value or repeat step #2 if you want to change the
measured value.

BT AzoaE e sall RV nzeaE & Sant] 03 e nzesE] all MRS nzea[E

JIDED HODE OPERATOR I DED HODE
198,/408 | DR PR
CRPTURE SPEE (1] ROADSIDE OFF
P — (21 CAPTURE TIHE (TBC)

L [11 (21
Enab led A5 Ter Einval Tesd

2811 11:48:22

Figure 53 Figure 54
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Manually Entering the Roadside Offset Distance:

1. Select the “Key In” option: -
Use the stylus to tap the [2] field in the message box, tap the button
LT AN NEERATOR 1D

or press the - soft key. {  ROADSIDE DFFSET
Figure 55 shows the message box that will be displayed. Range 1 to 188e

2. Use the stylus and on-screen keypad to enter the desired Roadside Offset.

Range = 1 to 100 metres

als|d|figlh|j/k]l]:|
¥|civibinm , ]

Default = 5.0 metres.

3. Tap or press the - soft key to accept the entered value.

Taking the DBC Measurement
When DBC Mode is active the icon is displayed at the top of the Touch Screen as Figure 56 shows.

Tap 3 or press the . soft key to start the DBC Mode. Remember to set the Roadside Offset
(page 40) before taking any DBC measurements.

1. Aim to the first/leading vehicle
of the pair and pull the trigger
to take a measurement. The
measured speed and distance
will be displayed, (1) in Figure 57.

1. Vehicle #1 (speed & distance)
2. Vehicle #2 (speed & distance)
3. Roadside Offset

4. Time between Measurements
5. Distance between Vehicles

6. Time between Vehicles

2. Aim to the second/trailing vehicle
of the pair and pull the trigger
to take a measurement. The BRDRESZ  1A/RILDEIT 14144140
results of the DBC measurement 6 s ' !

- HPH !
will be displayed and should n—.-S# n §
look similar to Figure 57 The B %l @
crosshair displayed on the image "
represents when the second/ 5 4

trailing vehicle was targeted.

Figure 56

3. Repeat steps 1 and 2 to capture additional DBC measurements.

« If either vehicle measurement generates an error, the instrument will
beep and return to the initial DBC screen, resetting the sequence.

* The time between the first and second measurements must be less than
three seconds. Otherwise, the instrument will emit a low-pitched beep,
cancel the operation, and return to the initial DBC screen. Figure 57

Figure 57
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DBC Measurement Requirements

Time Limit between Measurements: 3 seconds

Minimum distance between Vehicles: 4 metres

Minimum Vehicle Speed: 3 mph

Maximum Speed Difference between Target Vehicles: 5 mph

Minimum Capture Distance: 2.5 times the Road Offset Distance

The Minimum Capture Distance is the minimum distance that the TruCAM will accept a DBC
measurement.

The Minimum Capture Distance is 2.5 times Roadside Offset distance entered by the user.

If a vehicle measurement is taken and the distance to the vehicle is less than the Minimum Capture
Distance an error message is displayed and the measurement is aborted.

Measurements are always made front-to-front of each vehicle, or rear-to-rear. A front-to-rear or
rear-to-front measurement will result in an error message displayed and no DBC value will be
calculated/displayed.
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Section 6 - Playback Mode

To view previously captured motion clips/still images tap either

(yellow) or (red):

: Is available on the System Setup Screen.
: Is available on the Capture Menu.

: If it is not displayed, tap @ repeatedly or press the D soft key N

repeatedly until is displayed. 2 1 MPH

7.2 m

The most recently captured still image will be displayed as shown in

Figure 58. ® ®'@9

Figure 58

Initially, a preview of the file will be displayed.
Tap the or press the D soft key to load the motion clip and still image data.

To display the GPS data associated with the motion clip/still image, use the stylus to tap the Time/Date
data and toggle between Time/Date and GPS.

Function

Toolbar ‘ Alternative ‘

Button Soft Key

©

Tap to display the previous image in the current folder.

Tap to display the list of folders that are stored on the SD Card.

®

Tap to display the next image in the current folder.

S00

Tap to load the video and still image.

Displaying the Folders Stored on the SD Card
The TruCAM creates a folder each day that the TruCAM is used. Figure
59 shows an example of the screen that will be displayed when you tap B

or press the - soft key. The current date is assigned as the folder
name when the folder is created. In this example, there are 6 folders. The
highlighted folder is from January 21st and contains 1 *.jmf files.

The screen can display a maximum of 28 folders. If your SD Card
contains more than 28 folders, the most recent 28 are displayed. In this
case you will need to transfer the folders to your Office PC using the [1]

TruCAM Image Viewer Program (page 54)

or

[2] USB connection (page 12). Once the files have been transferred, then you can use the TruCAM
Image Viewer program to view the *.jmf files.
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Button Function

Toolbar ‘ Alternative ‘

Soft Key

Tap to select the next folder displayed on the screen.

Tap to select the previous folder displayed on the screen.

(@ |
(@]

Tap to change the brightness of the LCD Backlight (page 15).

Tap to load the image/still file.

Loading the Motion Clip / Still Image File

Figure 60(A) shows a preview of a *.jmf file. To playback the motion clip, it must be loaded.

Tap or press the D soft key to load the motion clip. Figure 60(B) shows an example of the
screen that will be displayed.

FANZAZRIR 11:38:48 . 4640245 -41 B9/12/2018 11138149, 344fessazn A9-1Z-20818 11 130 158 . 070

26| 26w 26

> M

2 0. 91® 90T e '8 eH

Figure 60

Tap ﬂ or press the - soft key Figure 60 (B) to start the motion clip playback and immediately
the clip begins to play.

Figure 60(C) shows the view of the final frame after the motion clip has finished playing offering
further options as described below.

Tap the or press the D soft key. Figure 60 (D) shows an example of the screen that will
be displayed.

This provides the operator with an opportunity to enhance the view of the final frame. Tap the
or press the - soft key to enlarge the detail on screen.
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Function

Button Soft Key

Toolbar ‘ Alternative ‘

Tap to preview previous *.jmf file.

Tap to display the list of folders stored on the SD Card.

Tap to preview next *.jmf file.

While the image is being previewed, tap to load the *.jmf file.
While the still image is loaded, tap to return to Playback Mode.

Tap to advance one frame of the motion clip.

DD elenE

Tap to playback the motion clip. As the motion clip is played, the
frame number is updated.

The Single triangle and triple triangle show playback speed. Single
is normal and triple is fast play during tracking.

In Figure 63(C), the marker that appears to the left of

the date and time represents 240 image size and has a total of 20
frames. During motion clip playback, the crosshair indicator displays
at the time and location on the target when the laser measurement
was taken. During DBC playback, the crosshair indicator displays
twice, noting the measurement time and target location for each
individual laser measurement during the DBC process.

This button is displayed while the image is being played back.
Tap to stop the motion clip playback.

Tap to reload the motion clip.

Tap to change the brightness of the LCD Backlight (page 16).

Tap to load the still image.

Tap to enlarge detail of the displayed image.

Tap to restore normal display.

Tap to return to Preview Mode.

E@oeD o
0jgs0nE B

Exiting Playback Mode

There are three ways to exit Playback Mode:

1. Pull the TRIGGER to start the Capture Mode. The Speed Capture Screen will be displayed (page 37).

2. Quickly press and release the Power Button two times. The System Setup Screen will be displayed
(page 18).

3 Double-tap the Battery Icon located in the upper right corner of the LCD Touch Screen. The System
Setup Screen will be displayed (page 18).

© Tele-Traffic UK Ltd 2011
45



Section 7 - Instrument Tests & Confidence Checks

Tele Traffic UK Ltd recommends the following tests be performed by an operator before or after
each shift to confirm proper instrument operation. The combination of operator-performed daily
checks and built-in instrument self tests provide positive indication of a system fault, should
one occur.

Self Test

When the TruCAM is powered ON, a number of internal checks are performed. During those tests all
display segments are lit and a series of tones are emitted.

When all of the tests have successfully completed, the Self Test Results Screen is displayed briefly
before the instrument is ready for use.

If any test fails, a system error message is displayed and the instrument will not operate. See page 17
for information about Self Test results.

HUD Integrity Test

Tele Traffic UK Ltd recommends that you perform this test before
or after each shift to verify that all in-scope display segments are
operating properly.

At power ON, compare the instrument’s in-scope Heads Up Display to
Figure 61. The lower portion of the display flashes 2 times and the aiming
reticule is illuminated. If the display times out before you can complete
this test, you will need to power OFF the TruCAM and repeat this step.

If any segment fails to display, contact Tele Traffic UK to arrange for repair.
See the inside front cover for Tele Traffic UK Ltd contact information.

Scope Alignment Test

Tele Traffic UK Ltd recommends that you perform this test before or after each shift to verify proper
alignment of the aiming reticule to the laser measurement beam.

Scope alignment is set at the factory when the instrument is shipped. A heavy blow is the only reason
that the aiming reticule might ever go out of alignment.

The Scope Alignment Test uses sound to indicate when the scope is on-target with the laser
measurement beam.

When the scope is properly aligned and you are targeting close targets, you may see a small vertical
offset due to the separation between the optics of the sighting scope and the laser transmitter.
Therefore, where possible when performing the Scope Alignment Test you should choose a target that
is at the longest distance available.
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1. Select a target. Choose a prominent target with well-defined horizontal and vertical edges.
A telephone pole or a Lamp standard are an excellent choices.

* The target’s reflective qualities and distance should be such that you can clearly hear a change in
pitch of the test tone as you pan the instrument over the edges of the target.

* Make sure there is nothing behind the target that the instrument might detect, so you know without a
doubt that any change in pitch is due strictly to the target.

2. Ensure that the TruCAM is powered ON.

3. From the System Setup Screen, tap or press the - soft key to W A6BAE Sl 40
activate the Test Tone display screen. It should look similar to Figure 62.

4. Scan the target. Press and hold the TRIGGER while panning the
instrument across the target. The tone changes pitch when the
instrument acquires the target. The highest pitch - the on-target tone -
should occur when the in-scope aiming reticule is centred on the target.
Scan the target both horizontally and vertically to confirm alignment in
both directions.

« If the test tone pitch decreases evenly off of each side of the target,
adjustment is not needed.

* The TruCAM counts the number of TRIGGER presses that are made
during the Scope Alignment Test.

After 5 TRIGGER presses, is displayed in the toolbar. Tap or press the D soft key to
save the date and time of the last Scope Alignment Test which is displayed on the Device Information
Screen (page 25).

« If there is a discrepancy between the on-target tone and the position of the aiming reticule, remove
the TruCAM from use and contact Tele Traffic UK Ltd to arrange for repair. See the inside front cover
for Tele Traffic UK Ltd contact information.

Always perform the Scope Alignment Test (previous page) before doing the Camera Alignment Test.
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Camera Alignment Test

1. Aim to the target that was used for the Scope Alignment Test and pull
the TRIGGER to activate the Speed Measurement Mode.

2. Position the aiming reticule on the target and take a measurement.
3. Immediately view the position of the video crosshair on the display and

make sure that it is aimed in the same location as the aiming reticule.

* If the video crosshair is in proper alignment, adjustment is not needed.
As an example, refer to Figure 63.

* If the video crosshair is not in proper alignment, remove the TruCAM
from use and contact Tele Traffic UK Ltd to arrange for repair. See the
inside front cover for Tele Traffic UK Ltd contact information.

Figure 63

Instrument Confidence Checks
There are several ways to verify the measurement accuracy of a Lidar instrument. You can verify it
directly by measuring the speed of an object travelling at a known speed, but this is seldom practical.

The nature of Lidar is such that it cannot be tricked by a vibrating object, such as a tuning fork, into
displaying a velocity. For these reasons, Tele Traffic UK Ltd recommends the Fixed Distance Zero
Velocity Test as an accurate method of verifying whether or not that the instrument is measuring correctly.

Tele Traffic UK Ltd suggests that you do one of these tests each time the instrument
is taken on duty.

These tests verify the accuracy of the two key elements of Lidar speed measurement:
1. Precise time measurements

2. Ability to make mathematical calculations

When setting up an area for these tests, Tele Traffic UK Ltd recommends:

« Permanently installing the test area in a convenient location. The test area must establish a
permanent, known distance between a shooting mark and a target (Fixed Distance Zero Velocity Test)
or between a shooting mark and two targets (Delta Distance Test).

« Using a metal tape to measure the distance; this will ensure that the measurement is accurate.

Other considerations:
« The shooting mark is where you stand to do the test, and it can be an “X” painted on the pavement.

« Atarget can be any flat, permanent structure, a sign or wall, for example, painted with a bull's eye or
other aiming point.

» The shooting mark and the target must form a straight line. The manner in which you stand and hold
the instrument both affect the test measurements. For exact readings, carefully hold the instrument so
the centre of the TruCAM is directly over the middle of the X.
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Fixed Distance Zero Velocity Test

In order to perform the Fixed Distance Zero Velocity
Test, the Speed Mode Eﬂ must be active.

Tele Traffic UK Ltd recommends that you perform
this test before or after each shift.

The Fixed Distance Zero Velocity Test requires one
target.

When selecting the target, keep in mind that the
distance to the target must be greater than the
minimum distance of the TruCAM.

The typical minimum distance is 20 metres, but
any distance can be employed over the minimum,
up to the maximum range of 750 metres.

To simplify the interpretation of the test results,
Tele Traffic UK Ltd recommends that the distance
between the target and the shooting mark be a
multiple of 1 metre, not a fraction of a metre.

1. Stand on the shooting mark. See Figure 64.

2. Ensure the TruCAM is powered ON and that the Speed Mode is active.

3. Aim to the target and pull the TRIGGER.

4. Check the display. The speed reading should be zero MPH (0 MPH)

as Figure 65 shows.

A reading of zero verifies the timing accuracy of the instrument and is
identical in nature to an accurate velocity reading of a vehicle moving

at any speed.

For absolute accuracy, the
instrument should be directly
over the shooting mark.

e 20to750———»|

metres

OR

For absolute accuracy, the
instrument should be directly
over the shooting mark.

‘%GO Metres——4
Figure 64

Figure 65

Tele Traffic UK Ltd recommends that you perform this test before or after each shift to verify
that the video crosshair displayed on the screen matches the position of the aiming reticule.

The video crosshair displayed on the screen is set at the factory when the instrument is shipped.
A heavy blow is the only reason that the camera and crosshair position might ever go out of alignment.

Example:

If the fixed distance was 60 metres an acceptable displayed distance result = from 59.8 to 60.2 metres.

Distance accuracy = +15 cm or 0.2 metres (rounded).

Speed accuracy = £1 MPH.

If you need assistance, contact Tele Traffic UK Ltd. See the inside front cover.
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Section 8 - Care and Maintenance

Operating Temperature

The TruCAM is rated for a temperature range of -10°C to +60°C (+14°F to +140°F). Do not operate the
instrument in temperatures outside that range.

When in storage, the TruCAM is rated for a temperature range of -20°C to +60°C (-4°F to +140°F).
Do not store the instrument in temperatures outside that range.

Moisture and Dust Protection

The TruCAM is sealed to provide protection from normally encountered field conditions. It is protected
from dust and light moisture.

Shock Protection

The TruCAM is a precision instrument and should be handled with care. It will withstand a reasonable
drop shock. If you drop the instrument, check the scope alignment (page 46) and camera alignment
(page 48) before using the instrument for speed measurement / video image capture.

Transporting

Use the provided carrying case when transporting the TruCAM. This is especially important when
transporting the instrument in a vehicle since sudden bumps or sharp cornering might damage
the instrument.

Cleaning and Storage

Clean the instrument after each use. Check for the following:

* Excess moisture. Towel off excess moisture and air dry the instrument at room temperature.
» Exterior dirt. Wipe exterior surfaces clean.

LCD Touch Screen. Use a soft cloth to wipe the screen. Do not use any liquid cleaners.

screen or allow excess liquid to drip into your TruCAM. Using soap or other cleaning products

i To reduce the risk of damage to the internal components, do not spray liquid directly on the
on the screen might discolour the finish and damage the screen.

« Scope Exterior. Use isopropyl alcohol to remove dirt and fingerprints.
* Lenses. Use a lens brush to remove surface dust and loose particles from the front panel lenses. To
clean a lens, moisten it with lens cleaning solution and wipe it with a clean cloth or lens tissue.

Battery Pack

If you won’t be using the instrument again soon, remove the Battery Pack before storing it.

Caring for the Scope
Do not attempt to lubricate the scope. It is sealed from within using o-rings and special compounds. All
seals are permanent and require no maintenance.

Use a lens brush to remove surface dust and loose particles. To clean a lens, moisten it with lens
cleaning solution and wipe it with a clean cloth or lens tissue.
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Caring for the LCD Touch Screen

To prevent damage to the LCD Touch Screen, never use any device other than the stylus that
comes with the TruCAM to tap on the LCD Touch Screen. If your stylus is lost or broken, please
contact Tele Traffic UK Ltd to order replacement stylus. See the inside front cover for Tele Traffic

UK Ltd contact information.

Realigning the LCD Touch Screen

If the TruCAM does not properly respond to your taps, the LCD Touch Screen may need to be
realigned. The “Align Screen” option is available on the Device Parameters Screen (page 26).

While the Calibration Screens are displayed, the Toolbar buttons are not active.

Do not tap m or . The soft keys located on the rear panel are active while the Calibration

Screens are displayed:

Press the - button to adjust the LCD Brightness Level.

Press the D button to cancel the realignment process and return to the System Setup Screen

without realigning the Touch Screen.

1. Display the Device Parameters Screen. Figure 66 (A) followed by (B) show how screens

should appear.

Use the stylus to tap the area indicated on the screen to “Proceed” and Align the screen.

[ waall

CAHERA POMER
68
DAT WRHAT
DO /AR YYYY
I { STORPGE

Disabled

® '@ e T

Figure 66 (B)

Figure 67 (A)

Please try again

@

Figure 67 (B) Figure 67 (C)

6

Tap target on screen

0y
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2. Figure 70 (A) shows the first Calibration Screen, it will prompt you to tap in the black box on the
upper left of the screen.

3. Figure 70 (B) shows the second Calibration Screen. Tap the target black box in the lower right
corner of the screen.

« If the process is successful, the data will automatically be saved and the System Setup Screen will
be displayed.

 If the process is not successful, a message will be displayed prompting you to “Please try again”
Start with Step 2 above.

4. Figure 70 (C) shows the third Calibration Screen. Tap the target black box in centre of the screen.

Restoring Factory Default Settings

1. Use the stylus to double-tap “Reset...”. Figure 68 shows the message box that will
be displayed.

ESET SETTINGS
ord Reguired
is powering off

Figure 68

2. Use the stylus to enter the user password.

3. As Figure 69 shows, the TruCAM Splash Screen will be displayed while parameters are reset.
Once all parameters are reset, the TruCAM will power OFF.

o LIVER:
@ TECHNOLOGY

prermrec by Lo A
Figure 69

Tap or press the D soft key to cancel without resetting the parameters. The Device
Parameters screen will be displayed.
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See table below.

Parameter ‘ Factory Default Value ‘ Page
AGC enabled 33
Backlight Timer 120 seconds 27
Camera Power 60 seconds 27
Capture Speed 0 19
Crosshair Classic 23
Date Format YYYY/MM/DD 28
Frame Rate 24 frames/second 28
GPS Interval 60 seconds 28
HUD brightness 6 10
Language Selection English 21
LCD Backlight Level level 3 16
Location S Tucson Way 19
Operator ID 23456 19
Power OFF Timer 600 seconds 27
Roadside Offset 5.0 metres (16.4 feet) 40
Shutter Speed 1/800 second 34
Speed Limit 0 19
Track Storage 8 29
User Password admin 29
Video Mode 1920x1440, 240x180 19
Video Tracking Distance & Mode 70 metres (229 feet) Enabled 19
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Section 9 - TruCAM Image Viewer

The TruCAM Image Viewer software runs on the Office PC and is used to:

v' Transfer motion clips (*.jmf files) from the SD Card to the Office PC.
v Play motion clips and view still images.

v Create *.avi format of a motion clip. The *.avi files can be viewed using a program such as Microsoft
Windows Media Player.

v Create *jpg format of a still image.

v Create a *.jpg format of a single frame of a motion clip.

v Create and manage Predefined Lists for Operator Names and Locations used on the TruCAM
System Setup Screen.

v Printimages.

v Select the language used for text display in both the TruCAM and the TruCAM Image Viewer program.

v" Check/repair the SD Card.

PC Requirements:

1. Operating System: Microsoft Windows 2000, Microsoft Windows XP or Microsoft Windows Vista
2. CD ROM Drive
3. USB Port

Installing the TruCAM Image Viewer Software

1. Insert the TruCAM Image Viewer Software CD in the computers CD-ROM drive. (Tele Traffic UK Ltd
may provide a USB 2 Memory Stick as an alternative.) The TruCAM Image Viewer Installation Wizard
will be displayed.

If Auto Play is not enabled on your PC, select Start > Run.

Enter X:\setup.exe. Where X is the letter of your CD-ROM drive.

Click the [ok] button. Setup will be initialised and the Installation Wizard will be displayed.

To complete the installation, follow the instructions displayed in the wizard.

A progress bar will be displayed as the software is installed.

Click the [Finish] button to close the wizard once the installation is complete.

Noobkwd

Starting the TruCAM Image Viewer Program l
TruCam
Yiewer

If you accepted the default location during the installation process, the software was
installed at the following location: C:\Program Files\LTNTruCAM Viewer\TruCAMViewer.exe

You can start the program
using the TruCAM Viewer Menu I — s i ]
desktop icon or from the Bar — liL it & & e CZOOtmI
computers Start Menu ontro
Still Image
> Programs > Laser Display Area
Technology, Inc > TruCAM
Viewer > TruCAM Viewer sisschye
Speed & Distance
Measurement
After you start the Display Area
program, the TruCAM
Image Viewer will be Wﬂ""‘:’;ﬂﬂm
displayed. It should look
like Figure 70.
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Using the Menu Bar

The Menu Bar includes seven pull-down menus. The table below lists the menus and the options
available on each menu.

Available :
: Function
Options
File Allows you to select the *.jmf file that you want to view. First you will be
Open Clip prompted to select a folder (laser serial number), and then a second folder
based on the date (MM_DD). Example of MM_DD is 05_04 = May 4th.
Displays Speed and Capture Limit detail, TruCAM firmware version number,
View Details TruCAM serial number, Last Alignment, Operator ID and Name, Image Capture
Date, Time and Location, and any GPS data related to the *.jmf file that is
currently displayed.
Transfer Clips . . g '
Moves or copies the *.jmf files from the SD Card to the Office PC.
from SD Card
Generates or updates the Summary. log file. This log file is a text file that
Refresh Clips contains one record for each *.jmf file transferred from the SD Card to the Office
Summary PC using the TruCAM Image Viewer program. By default, log file location is
C:\Program Files\LT\NTruCAM Viewer\.
Displays the Browse Clip Files window. This window includes the information
Browse Clips from the Summary.log file that was generated or updated using the “Refresh
Clips Summary” option (above).
Save Still Image Creates *jpg format of the still image.
Save Current . . . . .
Frame Creates a *.jpg format of the frame of a motion clip that is currently displayed.
. Creates *.avi format of the selected motion clip file.
Save Clip . . . . .
(Compressed) The *.avi files can be viewed using a program such as Microsoft Windows
Media Player. This option generates smaller file size.
. Creates *.avi format of the selected motion clip file.
Save Clip . o . . . .
The *.avi files can be viewed using a program such as Microsoft Windows
(Un compressed) . . ) —
Media Player. This option generates larger file size.
Exit Closes the TruCAM Viewer program.
Crosshair Classic Like the TruCAM, you can toggle the crosshair between
B Si Classic ' and Beam Size (default).
e A check mark appears to the left of the current selection.
Predefined Manage Operator | Allows you to create and manage the Operator Names Lists for use on the
Lists Names TruCAM System Setup Screen.
Manage Allows you to create and manage the Locations Lists for use on the TruCAM
Locations System Setup Screen.
Printing Prints two images from the *.jmf file that is currently displayed: (1) The frame
Print that displays the crosshair to indicate the speed and distance measurement. (2)
The final frame of the motion clip. Also includes the text data related to the *.jmf
file. (next page) shows an example.
While viewing images, you can tag or select individual images that you want to
Print Tagged print (page 59). This option allows you to print only the images that you tagged
while browsing.

Continued...
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...Continued

Available
Options

Function

Printing Displays the Print Selected Clip Files window that allows you to select multiple
* jmf files. Prints two images for each *.jmf file selected: (1) The frame that
displays the crosshair to indicate the speed and distance measurement. (2) The
final frame of the motion clip. Also includes the text data related to the *.jmf file.

Print Batch To select multiple *.jmf files:

Select this menu and option.

Navigate to the TruCAM serial number and date.

Press and hold the Ctrl (Control) key on the keyboard and use the mouse to
select the *.jmf that you want to include in the batch.

When ready to print, release the Ctrl key and click on the Print Selected button.

Language Displays the languages that are available to be loaded on the SD Card. Default:
Select TruCAM allows you to select a maximum of 4 languages. Displays the languages that
Languages are currently loaded on a particular SD Card. U.K specification will have only

English as an option.

Displays the current language displayed in the TruCAM Image Viewer program.
This allows you to change the language displayed in the TruCAM Image Viewer
program. U.K specification will have only English as an option.

Select Viewer
Languages

SD Tools i i i i i
Check & Repair Qhecks the |_ntegr|ty of the SD Card file system. Repairs the SD Card file system
if a problem is found.

About N/A Displays the TruCAM Image Viewer Software version number and copyright
information. Tap the OK button to close the About Screen.

File: 1285673045_w7000_0928_112405.jmf

Date: 09/28/2010 Time: 11:24:05

TruCAM Serial No: TC000480
Officer Name: 00000559
Officer ID: 0559

Measured Speed: 34 MPH
Measured Distance: 70.7 m

Speed Limit: 10 MPH
Capture Speed: 12 MPH

Location Code: 12345678

Figure 71
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Transferring the *.jmf Files from the SD Card to the Office PC

Each *.jmf file includes the motion clip, still image, and all associated text
data. The number of files that can be saved on each SD card depends upon
the SD card size, the image size selected and the length of video captured
for each file. For a 4 GB SD card, the average is approximately 2,000 files
stored. TruCAM Image Viewer makes it easy to transfer the *.jmf files from
the SD Card to the Office PC. During the transfer process, you will be

prompted to delete clips from the SD Card (Figure 72).

1. Remove the SD Card from the TruCAM.

2. Insert the SD Card into the SD Card Reader and then insert the
SD Card Reader into an available USB port on the Office PC.

3. In TruCAM Image Viewer select File >Transfer Clips from SD Card.
» Click on the answer to this question: Delete Clips from SD Card?

If you receive an error message that the SD Card is not
found, just clear the error message and a window will
be displayed, prompting you to navigate to the SD Card.
Example Location: My Computer > Removable Disk >

TruCAM > film

« If you click the [Yes] button, the files will be moved from the

Transferring Clip Files

Figure 72

Eh

Figure 73

SD Card to the Office PC. The files will no longer reside on

the SD Card.

+ If you click the [No] button, the files will be copied from the SD
Card to the Office PC. The files continue to reside on the SD Card.

» As Figure 73 shows, a progress bar will be displayed.

Click the Cancel button if you want to stop the transfer process.
* When the transfer process is complete, a message box will be

displayed as Figure 74 shows.
4. Click the OK button to clear the message.

Browsing the *.jmf Files

1. Transfer the *.jmf files from the SD Card to
the Office PC (see above).

2. Select the File Menu > the Refresh Clips
Summary option. An hourglass may be displayed
during this process.

3. Select the File Menu > Browse Clips option.
The Browse Clip Files window will be displayed.
(Figure 75). Initially, the left display window
includes a folder icon titled “Movie Clips” and the
right display window is blank.

4. Use the mouse to click on the “+” symbol to the
right of the folder icon. You will be prompted to
select the TruCAM serial number > image capture
date > *.jmf that you wish to view.

5. Select the View button to display the selected *.jmf file.

» Select the Close button to close the window without
viewing a *.jmf file.

Fie Transter Complebed Successhuly.
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To open one particular *.jmf file:

1. Select the File Menu and then the Open Clip option.

2. Select the folder that corresponds to the TruCAM serial number.

3. Select the folder that corresponds with the date that you want to view.
4. Select the file that you want to view.

5. Click the Open button (or double click in step 4).

If your files are not stored in the default location, select the File Menu > Open Clip option and then
manually navigate to locate the *.jmf file that you want to open.

Figure 76 shows an example of a *.jmf file displayed in TruCAM Image Viewer.

Motion Clip Measurement type Zoom Level & Buttons

File name Speed, DBC or Video (In, Out and Restore)
Tag to Motion Clip Still Image
Print Counter Size

Final Frame of
the Motion Clip

Scroll to previous or
next Motion Clip

— > = - T SR PSSR P w1 b

Chp M 200 Dale (OO0 T (0008 =
L fpmed M P Dlsswe $TE

Motion Clip Display

b rew 1 a » > e

L
Mﬁ*-&

Frame Data

Motion Clip buttons —
(Start, stop, last & first frame)

Frame image at the time Speed
& Distance was measured. —

el L

Measurement Results | ot wram
(Speed & Distance) e

Figure 76

To scroll to the next *.jmf file, select the » at the top of the MOTION CLIP display area.
To scroll to the previous *.jmf file, select the < above the MOTION CLIP display area.

* As you scroll through the *.jmf files, the images, Detail Summary, Motion Clip Counter, Still Image
Size, Frame Data, and Measurement Results will update.

« The crosshair indicator displays at the time and location on the target when the laser measurement
was taken. During DBC playback, the crosshair indicator displays twice,noting the measurement
time and target location for each individual laser measurement during the DBC process.
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To view the more detail information related to the *.jmf file, select File > View Details. Figure 77 shows an
example. You may see additional data, depending upon the features of your TruCAM, capture mode, etc.

s
3

Mt St B Frmegis: 20000 100.200.0.19%
Mg [md e L Sewial ho:  TCODOATY
lpratir: (1,

w
Coaphare Speed. L
Lt Algrad.  OITTZO00 09I
Serewt Codde:
[ 8 [H 2 Tens: RIE ]

Figure 77

To tag this image to print later, use the mouse to click on the box that appears to the left of the “Print”,
the Tag to Print option shown in Figure 76. When ready to print all tagged images, select the Printing

menu > Print Tagged option.

For information about printing, see pages 55-56.

Playing a Motion Clip
The Motion Clip Control buttons are available whenever the displayed *.jmf file includes motion frame data.

- MOTION CLIP -4 MOTION CLIP

oo 8] ] ] ] e i -
12{08/2010 11:30:45. 464 12/09{2010 11:30:50.673
First Frame Last Frame

Figure 78

@  Select to display the Large Clip Viewer window.
>

Select to play the motion clip.
[ Select to stop the motion clip.
I»  Select to advance to the next frame of the motion clip.

I Select to return to the first frame of the motion clip.
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Section 10 - Troubleshooting Tips

If you have a problem with your TruCAM, use the table below to troubleshoot the problem. Additional
troubleshooting tips may be available on the Tele Traffic UK Ltd web site. If you are experiencing a
problem that is not listed here or if you need assistance resolving a problem, please contact Tele
Traffic UK Ltd for assistance. See inside front cover for Tele Traffic UK Ltd contact information.

Problem

The LED Charge Indicator is not lit during the
charging process.

Remedy

The battery charge is too low. Leave the TruCAM
plugged in for at least one hour to trickle charge
the cells.

After one hour, disconnect and reconnect the
charging cable.

If enough charge is present, the LED Charge
Indicator should be orange (page 7).

When | powered ON the TruCAM, it displayed an
error message.

Try 2 or 3 measurements, it may be automatically
cleared. If it is not cleared:

Power OFF the TruCAM.

Remove and re-insert the Battery Pack.

Power on the TruCAM one more time to repeat
the Self Test.

If the error repeats, contact Tele Traffic UK Ltd for
assistance. See inside front cover for Tele Traffic
UK Ltd contact information.

The TruCAM is powered ON and is not responding
to any taps or button presses.

Remove and then re-insert the battery pack.
Press the Power Button or pull the TRIGGER to
power ON the TruCAM.

The TruCAM is not responding properly to taps and
double-taps.

The LCD Touch Screen needs to re-aligned.
Access the Device Parameters Screen.

Select or double-tap the Align Screen “Proceed”
option. Follow the prompts to re-align the screen.

| changed the time zone on the System Setup
Screen, but the Date & Time was not updated.

The change is not immediately displayed. The Date
& Time is only updated when the GPS has a fix. In
most cases you will have to be outside and cycle
the TruCAM OFF

On the Device Information Screen, the Last
Alignment Check displays an incorrect date.

The Last Alignment Check is only updated after you
have a completed a minimum of 5 test tones. You

may have completed less than 5 test tones. Repeat
the Scope Alignment Test (page 46) and remember

to tap D or press to save the test results
before exiting the screen.

The various Power OFF intervals are inconvenient,
either too short or too long. When intervals are too
long, it drains the battery charge.

The default values associated with the various Power
OFF intervals are designed for battery life. The
Power OFF intervals can be extended or shortened
on the Device Parameters Screen (page 27).

| want to increase the on-time of the GPS.

Set the GPS interval to 0 to prevent the GPS
from powering OFF (page 28). Note: the continual
on-time will shorten battery life.
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Previously changed the user password, and have
forgotten what it is.

Contact your Authorised Tele Traffic UK Ltd for
assistance. See inside front cover for Tele Traffic
UK Ltd contact information.

Date and/or time is incorrect.

Update on the System Setup Screen (page 20).

During the Manned Auto Mode, only still images
are produced, video clips are not produced.

If you require video clips, select the Unmanned
Auto Mode.

Difficult to see the LCD Touch Screen.

Tap 3 to adjust the intensity of the LCD Backlight,
Attach the Sun Shade.
Change your location in relation to the sun.

The TruCAM is powered ON, but do not know how
to start the Speed Mode.

Pull the TRIGGER.

The in-scope aiming reticule is not visible.

Pull the TRIGGER to activate the aiming reticule.

Tap to increase the intensity of the aiming
reticule. Adjust the polarizing filter.

Measurement Error: Unstable Targeting.

Attach the Shoulder Stock (page 35) or mount the
TruCAM on a tripod.

| want to increase the on-time of the GPS.

Set the GPS interval to 0 to prevent the GPS
from powering OFF (page 28). Note: the continual
on-time will shorten battery life.

Erroneous speed measurements / not repeatable.

Do you have a clear line of sight?

Check the scope alignment.

Is it raining or foggy. If yes, is the Weather Mode
active? If not, turn it ON. Keep in mind that the
minimum range will be 61 metres.

When measuring a short range to a small target,
aim slightly above the target.

Limited range.

Do you have a clear line of sight?

Rain or fog will reduce the unit's maximum range.

Is the Weather Mode active? If not, turn it ON. Keep
in mind that the minimum range will be 61 metres.
Keep in mind that acquiring a target through glass
will reduce the unit’'s maximum range.

Make sure the Transmit and Receive Lenses

are clean.

Check the Transmit and Receive Lenses for
scratches.

Images are fuzy.

Keep in mind that the optimum targeting distance
is 70 metres. Hand-held: 15 - 80 metres. Tripod
mounted: 15 - 90 metres. You may need to adjust
the Video Tracking Distance (page 19), Camera
settings (page 32).

Difficulty acquiring target while aiming through rain
or Snow.

Is the Weather Mode active? If not, turn it ON. If
not, turn it ON. Keep in mind that the minimum
range is 61 metres. It may be necessary to adjust
the Video Tracking Distance (page 19), Camera
settings (page 33).
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Images are too dark. —>»

Shutter speed - F-number - AGC <optional> —
brightness level <optional>

Try to set slower shutter speed, like 600, 400 or 800
instead of 1KO or 1K5.

If it is still dark, you may open the aperture a little
bit, however do not open too much.

Always maintain bigger F-number.

Examples: F-number should be 8 to 11 for cloudy
and foggy, and 11 to 16 for sunny day.

Adjust your location so the sun is on your back and
behind the Camera and illuminates the Licence
plate. <optional> Turn on AGC (page 33).

Images are too light.

F-number — shutter speed - AGC <optional> —
brightness level <optional>

Try to set faster shutter speed, like 1KO or 1K5
instead of 600, 400 or 800.

If it is still light, you may close the aperture a little
bit, however do not close too much.

Always maintain bigger F-number.

Examples: F-number should be 8 to 11 for cloudy
and foggy, 11 to 16 for sunny day.

<optional> Turn on AGC (page 33).

<Message>

WRITE PROTECTED
Unlock SD Card

Powering Off in 60 seconds

After the TruCAM powers OFF, remove the SD
Card. Slide the small plastic toggle out of the
‘lock’ position.

ko imapston

- | L'_‘z,'.'
==

EEasnn

<Message>
INVALID SD CARD

This message is displayed when you pull the
TRIGGER to start image capture and your TruCAM
does not recognise the SD Card as being registered.
Contact Tele Traffic UK Ltd for assistance.

| connected the TruCAM to my computer using a
high-speed USB 2.0 cable and the “High Speed
USB” message was not displayed.

Verify that the TruCAM is powered ON and that
both ends of the cable are connected properly.

Using the USB connection, it is not possible to
delete files from the SD Card.

Using the USB connection, files on the SD Card
are Read Only. In order to remove files from the
SD Card, use the SD Card Reader that provided
with your TruCAM.

Still image/motion clip files are large. Want to be
able to store more files on the SD Card.

For a4 GB SD Card, the average is

approximately 2,000 files stored. If you find a

4 GB SD Card stores less than that, you may

want to change the Video Mode setting to 1920/240
(page 19) and also decrease the Frame Rate and
Track Storage (page 27).
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In Playback Mode when listing folders of motion
clips/still images, not all folders are listed.

The TruCAM interface displays the most recent

28 folders. If the SD Card contains more than 28
folders, you will need to transfer files to your Office
PC using the [1] SD Card reader that provided with
your TruCAM or [2] USB connection (page 12).
Then you can view the motion clips/still images
using the TruCAM Viewer program.

In Playback Mode when displaying folder contents,
two files have the same file name.

If the Battery Pack is accidentally removed or the
SD Card is rejected while a film clip is being saved,
the Film Number may be not increased. The folder
will have two motion clips that have the same Film
Number and the first file will be damaged

| did not use the TruCAM Image Viewer program
to transfer the *.jmf files to the Office PC, and
now | want to use the Viewer program to open
the *jmf files.

In the TruCAM Image Viewer program, select
File > Open Clip option. Then manually navigate
to the folder that contains the *.jmf file that you
want to view.
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Section 11 - Additional Information

Error Conditions
Although it is rare, error conditions can occur during a measurement attempt or in the system hardware.
To make sure that you never get an erroneous speed reading, the TruCAM monitors both the system

hardware and the measurement. When the instrument detects an error condition, it displays an error
message instead of a measurement.

Error Messages

The table below lists the possible error messages related to speed measurements. This is not a complete
list, there are additional error messages that may be displayed on the LCD Touch Screen. Generally,

the error messages are self explanatory. You will need to tap OK to clear the error message, correct the
cause of the error and then retry the action that had caused the error message to be displayed.

Message and Explanation Code
Measurement Error - the target was out of range or was too close. E 01
Measurement Error — insufficient data. The unit does not have enough data to
. i . . E 02
measure speed. Possible Cause: early release of the trigger or time out.
Measurement Error - unstable targeting. Data is not stable enough to measure
speed. Possible Causes: poor aiming or panning off the target.
E 03
Measurement Error - low level of interference from a light source such as a
xenon headlight.
Jam Detect - high level of interference from a light source such as a xenon
. . . ; E 07
headlight or other smart jamming device.
Temperature too cold. Stop operation. E 52
Temperature too hot. Stop operation. E 53
Calibration Errors. Please turn OFF unit and try again. If the same error is E55 ES57
continuously repeated, please contact Tele Traffic UK Ltd. ** E56 E 58
Memory failure. Please turn OFF unit and try again. If the same error is E 60
continuously repeated, please contact Tele Traffic UK Ltd. **
Receiver Failure. Please turn OFF unit and try again. If the same error is E 62
continuously repeated, please contact Tele Traffic UK Ltd. **
General System Failure. Please contact Tele Traffic UK Ltd. ** E 99

See front cover for Tele Traffic UK Ltd contact information.

RFI Considerations

The TruCAM does not display a specific error message indicating the presence of radio frequency
interference (RFI).

The instrument’s electronics have been designed for optimum RFI immunity. If RFI is present, the
instrument displays an error message. The exact code depends on the level and nature of the RFI.
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Sounds from the TruCAM

The TruCAM emits a variety of beeps and tones during use. The sounds vary and depend on what the
instrument is doing. The table to the right is a partial list of some of the sounds that you will hear.

Sound | Explanation
? hci)g\]l\r:?;[ti:hhzc(’j a;:eps AtPower ON.
Low-Pitched Growl The instrument is attempting to lock onto a target for a speed measurement.
1 Low-Pitched and The instrument was not able to complete the intended speed measurement due to an
2 High-Pitched Beeps error. An error code will be displayed to the indicate the nature of the error (page 64)
High-Pitched Single Beep The instrument successfully completed the intended speed measurement.

Icons that Appear at the Top of the TruCAM LCD Touch Screen
The icons are the images that display at the top of the LCD Touch Screen.

Icon | Explanation

LTI logo
Tap to capture *.bmp image of the image that is displayed on the LCD Touch Screen.

Automatic Gain Control (AGC). See page 33.
Displayed: AGC is on.
Not Displayed: AGC is off.

Shutter Speed. See page 34.
200: 1/200 second

400: 1/400 second

600: 1/600 second

800: 1/800 second

1K0: 1/1000 second

1K5: 1/1500 second

2KO0: 1/2000 second

M
=
=

HE
=
o=

e
[EE
[~ =]

Night Time Operation

Requires LTI IR Flash.

Displayed: Night Time Mode is active.

Not Displayed: Night Time Mode is not active.

e

Zoom Factor (Fine Motion Clip Mode = 480 x 360 pixels)
Yellow box indicates the Fine Motion Clip Mode.

Normal + 1 zoom level.

Normal display is represented by the thick white outline.
Zoom display is represented by the thin white outline.

Zoom Factor (Coarse Motion Clip Mode = 240 x 180 pixels)
Black box indicates the Coarse Motion Clip Mode.

Normal + 3 zoom levels.

Normal display is represented by the thick white outline.

As the display zooms in, the white outline gets thinner.

GPS Information
Displayed: TruCAM is in the process of receiving GPS information.
Not Displayed: TruCAM is not currently in the process of receiving GPS information.

=1 EEE[E O
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Speed Mode Status
Displayed: Speed Mode is active.
Not Displayed: Speed Mode is not active.

Distance between Cars (DBC)
Displayed: DBC is active.
Not Displayed: DBC Mode is not active.

Video Only Mode
Displayed: Video Only Mode is active.
Not Displayed: Video Only Mode is not active.

Rear Plate Mode
Displayed: Rear Plate Mode is active.
Not Displayed: Rear Plate Mode is not active.

@ H 8 E

Weather Filter
Displayed: Weather Filter is active.
Not Displayed: Weather Filter is not active.

LCD Backlight Level

-
~
'

2@11]] 0 = dimmest
Bl 1

il 2

'.Wi|||] 3 = default
‘.m‘||| 4 = brightest

Approximate Battery Voltage Level

4 segments lit = 75% - 100% estimated battery life.

3 segments lit = 50% - 75% estimated battery life.

2 segments lit = 25% - 50% estimated battery life.

EEEE

1 segment lit = 5% - 25% estimated battery life.

=

0 segments lit and red X’ = 5% or less estimated battery life.
You need to replace or recharge the battery pack as soon as possible.
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TruCAM Tool Bar Buttons

The toolbar is located at the bottom of the LCD Touch Screen. The table below includes the various
buttons that appear on the toolbar. The colour at the top of each column corresponds to the soft key
located on the TruCAM’s rear plate that may be used as an alternate to tapping the toolbar button.

Confirm or Confirm or Iéggk“ ht @ Confirm or
Select Select Level 9 Select
Display
Scope ﬁ HUD
9‘ Alignment y‘ Intensity - gif;em I\P/Ilca:é/Zack
Test — Level P
Screen
Playback L Rear Plate O |
Mode == N ,_""" Speed Mode b4 Cancel
Previous Video Only ‘ r'! '
Display Next
. . . . Distance 3 Options on
Night Time 'Q\ Automatic e @
- ( —>
L ol | Mode Gain Control | kel téeat;l\sleen tSh:Sgi(a)Eture
Toolbar
qﬁ Shutter Weather (9 Display Next Q Load
Speed Mode - Image Still Image
(9 Previous Display List
Image of Folders
‘; Advance Reload
- 1 Frame Motion Clip
=l - B
Laser
Measure Play
- DBC ? Motion Clip
Roadside
Offset
Stop
Motion Clip
-<: Zoom Out
Manually
[' 2 ] Enter DBC
Roadside
Offset
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Glossary

AGC:

Aperture:

Beam divergence:

Delta Distance Test:

Depth of Field:

F-stop:

Fixed Distance Test:

Focal length:

HUD Integrity Test:

Iris:

Laser:

Lidar:

Microcontroller:

Receive Lens:

Reticule:

Automatic Gain Control. Optimises picture quality at all times during
the day. It increases the video signal at low light levels to make the
picture brighter.

A unit of measurement that defines the size of the opening in the lens
that can be adjusted to control the amount of light that reaches the
digital sensor. The size of the aperture is measured in F-stop.

The tendency of a laser beam to expand in diameter as it moves away
from the source, measured in milliradians (mrad).

Optional Feature. Uses two measurements each to a known distance to
verify the measurement accuracy of the TruCAM.

DOF. Unit of measurement that represents the range of distances within
an image where the focus is acceptably sharp.

Refers to the international standard sequence of numbers that express
relative aperture. F-stop is the “lens focal length” divided by the “effective
aperture diameter.” The smaller the F- number, the greater the amount
of light that passes through the lens. Each change of F-stop halves or
doubles the image brightness as you step up or down.

Uses one measurement to a known distance to verify the measurement
accuracy of the TruCAM.

Refers to the size of the image and angle of field of view as seen by the
camera through the lens.

Heads Up Display Integrity Test. Allows you to verify that all segments of
the in-scope display and aiming reticule are operating properly (page 46).

An adjustable aperture used to control the amount of light coming
through the lens. The more the iris is opened, the more light it lets is
and the brighter the image will be.

Light Amplification by Stimulated Emission of Radiation.

A device that is similar in operation to radar, but emits pulsed laser light
instead of radio waves.

The computer processor that controls all of the functions of the TruCAM.

Located on the front panel of the TruCAM, it is the bottom lens and
receives the signals back from the target and then feeds the signal
information to the microcontroller.

A scale located in the sighting scope that helps you aim to your target.
It is visible when the TruCAM is powered ON. You may need to pull the
TRIGGER to see the reticule.
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Self Test:

Shutter speed:

Transmit Lens:

Weather Mode:

White balance:

Zero Velocity Test:

At power ON, a number of internal checks are performed. During those
tests all display segments are lit and a series of tones are emitted.
When all of the tests have successfully completed, the Self Test Results
Screen is displayed briefly before the instrument is ready for use. If any
test fails, a system error message is displayed and the instrument will
not operate (page 17).

The length of time that the shutter remains open as the image is
captured, and is very critical for image quality. Choose lower values as
much as possible. The shutter speed and aperture together control the
total amount of light reaching the sensor. Shutter speeds are expressed
in fractions of a second.

Located on the front panel of the TruCAM, it is the top lens and
transmits the infrared laser signals.

Alternate speed measurement mode. The laser only acquires targets
that are beyond the range where weather affects the laser’s ability to
capture a speed reading. Targets must be at a distance greater than
61 metres.

Compensates for lighting conditions, and allows the camera to “see”
white under a given lighting condition.

See Fixed Distance Test.
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Section 12 - Specifications

Performance

Optimum Focus Distance:

70 metres

Lens Operating Range:

Hand-held:
Tripod mounted:

15 - 80 metres
15 - 90 metres

Speed Accuracy:

+ 1 mph

Speed Range

0 mph to 200 mph approaching and departing

Distance Accuracy:

115 cm absolute accuracy

Display Resolution: Speed: 1 mph
Distance: 0.1 metre
Minimum Measurement Distance: Speed Mode: 20 metres

Weather Mode: 61 metres

Maximum Measurement Distance:

750 metres

Measurement Time:

0.33 second

Maximum Laser Sampling:

up to 3 measurements per second

Units of Measure:

Speed:
Distance:

miles per hour
metres

Laser Power:

90 microwatts nominal

Laser Wavelength:

905 nanometres nominal

Beam Divergence:

2.5 milliradians nominal

Eye Safety:

Physical Construction

FDA Class 1 (CFR 21) IEC 60825-1

Body: Composite Polycarbonate outer shell, aluminium internal chassis
Weight: 1.50 kg (Includes Battery Pack; does not include SD Card.)

3.30 pounds
Size: 21.0cmx 9.8 cm x 31.7 cm

Environment:

NEMA 4 / IP55 Water and Dust Resistant

Temperature Range:

Operating: -10°C to +60°C
Charging: 0°C to +45°C
Storage: -20°C to +60°C

© Tele-Traffic UK Ltd 2011
70



Hardware

Processor:

Computer: AT32AP7000; 147.45 MHz
Laser Core: LPC2136; 40 MHz, 20 PPM

System Memory:

64 MB SDRAM (73.7 MHz)

Capture Data Storage:

Removable SD Card: 2 GB and greater
SD file system formats: MS-DOS (FAT16, FAT32)
Linux (EXT2, EXT3)

Display:

2.7 inch (6.9 cm), 240x320 pixel, colour, 18 bits per pixel (bpp),
touch sensitive

Camera Sensor:

3.1 MPixel (2048x1536)

Camera Lens:

75 mm, manual focus and iris

GPS:

Receiver: Channels: 20
Max Update Rate: 1Hz
Max Altitude: 18,000 metres
Maximum Velocity: 515 m/sec
Sensitivity: Acquisition: -142 dBm
Tracking: -159 dBm
Acquisition Times: Hot Start: <1s
Cold Start: <35s
Re-acquisition: <15s
Accuracy: Horizontal Position:
Average: 2.2 metres
Maximum: 10 metres, autonomous

5 metres, SBAS corrected
Vertical Position:

Average: 0 metres

Maximum: 15 metres

Horizontal Velocity: 0.1 m/s (0.3 ft/s)
Time Accuracy: Synchronized with GPS: 1 us

Real Time Clock:

CR3032 backup battery: 20 PPM
3 years without main battery pack

Input/Output (1/0)

RS232, serial communications port
RS485, night time flash signal

USB 2.0, image data transfer

Touch panel input

6 button inputs (including TRIGGER)
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Power

Battery Pack:

7.4 v dc, Lithium-ion Polymer rechargeable battery pack, short circuit and
overcharge protected, providing up to 15 hours of cordless operation.

Battery Charger:

Main Charger: 110 v ac to 240 v ac 50/60 Hz input
12 v dc / 1.8 A output (or better)
Automobile Charger: 11 v dc to 16 v dc, cigarette plug connector

with 3 Amp fuse

Power Consumption:

Software

Operating system:

Standby: 950 mW (typical)
Laser Firing: 2400 mW (typical)

Linux based, with custom device drivers

Anti-Jam: Automatic laser jammer avoidance
Video Size: Standard Format: 240x180 pixels
Extended Format: 480x360 pixels
Video Modes: Selectable video capture frame rate before the measurement and based
on motion clip size selection:
240x180 (Coarse): 24 fps or 18 fps or 12 fps
480x360 (Fine): 14 fps or 11 fps or 9 fps
Track Storage: Selectable frame storage after the measurement and based on the current
Frame Rate: | approximately 1/3 of the Frame Rate

| same as the Frame Rate
| approximately 1/6 of the Frame Rate

Still Image Sizes:

Selectable: 1920x1440 pixels

1440x1080 pixels

Maximum Record Size:

120 seconds (2 minutes) or 8 MB which ever occurs first.

Data Encryption:

AES-128
United States Federal Information Processing Standards, Advanced
Encryption Standard - 128 bit.
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IndeXx

A D

Accessories 1 Dark images 62

AGC. See automatic gain control Data encryption 72

Aiming reticule 10, 68 Data entry

Not visible 61 Keypad 15

Align LCD touch screen 51 Date
Format 28

Aperture 68 System Setup Screen 18

Automatic gain control (AGC) 33, 68 Date and time
Troubleshooting 60

B Depth of field (DOF) 33

Backlight 16 Desktop icon

Battery TruCAM Image Viewer 54

gEarger 7§ Device Information Screen 25

Coér::g:r?ment 3 Device Parameters Screen 26

Icon 9 Display

Release 3 Resolution 70

Battery pack 3, 71 Specifications 71

Inserting or removing 8 Distance accuracy 70

Precautions 6 Distance between Cars (DBC) Mode 39

Beam divergence 68, 70 Dust protection 50

Beam size crosshair 22, 55

Browse Clips E

TruCAM Image Viewer 55, 57 Error messages 64
Troubleshooting 60

C Excess moisture 50

Camera Exterior dirt 50

Cover 3, 9 Eye safety 2, 70

Lens 3, 71

Lens focus distance 22, 34 F

Power OFF interval 26,27

Sensor 71 Factory default values 53

Camera Alignment Test 48 File menu

TruCAM Image Viewer 55

Film number 25

Fixed Distance Zero Velocity Test 49
Focal length 68

Capture speed 19
Charging cable 6

Charging the battery pack 6
Check & Repair SD Card

TruCAM Image Viewer 56 Focus adjustment ring 9
Classic crosshair 17, 55 got{:us di;(t)ance

. mum
Cleaning 50 P

Frame rate 28

Coordinated Universal Time (GMT) 20
Front panel 3

Cosine effect 31

How to minimise 32 Fs check 23
Crosshair F-stop 33, 68
TruCAM 23 Fuzzy images 61

Crosshair menu
TruCAM Image Viewer 55
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G
GPS

Interval 28
On-time 61
Receiver 13
Specifications 71

H
HUD Integrity Test 68

Icon
Battery voltage 9

Icons
List 65
Location 14

Input/output 71
Installed devices 25
INVALID SD CARD

Error message 62
Iris 33, 68
Iris adjustment ring 9

J
Jam detect 14

K
Keypad 15

L

Language menu
System Setup Screen 21

Laser 68

Power 70

Sensors 9

Last alignment check 26
Troubleshooting 60

LCD backlight 16
Power OFF interval 27

LCD Touch Screen 14
Caring for 51

Difficult to see 61
Realigning 51

LED charge indicator 3, 60
Licence manager 24
Licensed functions 25
Lidar 68

Light images 62

Limited range 61

Line of sight 31

Linux operating system information 25
Locating *.jmf files on TruCAM 43

Location 19
DBC Mode 39
Speed Mode 37

M
Manage Locations 55

Manage Operator Names 55

Maximum record size 72

Measurement
DBC Mode 39
Distance 70

Rear Plate Mode 38
Speed Mode 37
Weather Mode 38

Measurement units 23
Memory storage 20

Menu bar
TruCAM Image Viewer 54

Microcontroller 68
Moisture protection 50

Motion clip Control buttons
TruCAM Image Viewer 59

Motion clip sizes 19

(o)

Open Clip 55
Opening files

TruCAM Image Viewer 57

Operating system 72
Operating temperature 50
Operator ID 19

P
Password 29

PC requirements
TruCAM Image Viewer 54

Playback Mode 43

Playing a motion clip
TruCAM Image Viewer 59

Power button 3

Power consumption 71
Power OFF intervals 18
Power OFF timer 27
Power supply 6
Powering ON/OFF 18
Precautions 1

Precharging routine
Battery pack 7

Predefined Lists menu
TruCAM Image Viewer 54

Print Batch option 56
Print option 55
Print Tagged option 56

Printing menu
TruCAM Image Viewer 54
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R

Radio frequency interference (RFI) 64
Rain/snow 61

Real Time Clock (RTC) 71

Rear panel 3

Rear Plate Mode 38

Receive lens 3, 68

Refresh Clips Summary 55

Reset settings 29, 51

Roadside location 31

Roadside offset
DBC Mode 40

S

Safety. See precautions

Save Clip
Compressed 55
Un-compressed 55

Save Current Frame 55
Save Still Image 55
Scope Alignment Test 46

Screen: Device Information 26
Device Parameters 26

Self Test Results 17

System Options 22

System Setup 18

TruCAM Splash 17

SD Card 11
How to unlock 59
Slot 3

SD Tools menu
TruCAM Image Viewer 56

Select TruCAM Languages 56

Self Test 17, 46, 68
Results display 25

Self Test Results Screen 17
Serial number 25

Serial port 3, 14

Shock protection 50
Shoulder stock release 3
Shutter speed 69

Sighting scope 3, 10
Caring for 51

Soft keys
Description 15

Sounds 65
Speaker 3
Specifications 70
Speed accuracy 70
Speed limit 15

Speed Mode 37
How to start 61

Speed range 70
Still image sizes 19, 72

Storage temperature 50
Stylus and holder 3
System memory 71
System Options Screen 22
System Setup Screen 18

-

Temperature range 70
Time
System Setup Screen 20

Toolbar buttons 15
List 67

Track storage 29, 72
Transfer Clips from SD Card 55

Transfer files from SD Card to Office PC 57

Transmit lens 3, 69
Transporting the TruCAM 50
Troubleshooting 60

TruCAM
Languages 21

TruCAM Splash Screen 17
TruCAM Version 25

U

Unlock SD Card 62
USB port 12

User password 29
Troubleshooting 61

UTC. See Coordinated Universal Time

Vv

Version number

TruCAM 25
TruCAM Image Viewer 54
TruCore 25

Video mode 19
Video Only Mode 39
Video size 72

View Details 55

Views
Of the TruCAM 3

w
Wavelength 71
Weather Mode 38, 69

White balance 69

WRITE PROTECTED Unlock SD Card
Error message 62

V4
Zero Velocity 69
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